Disclaimer:

PLAXIS is a finite element program for geotechnical applications in which soil models are used to simulate the soil behaviour. The PLAXIS code and its soil models have been developed with great care. Although a lot of testing and validation have been performed, it cannot be guaranteed that the PLAXIS code is free of errors. Moreover, the simulation of geotechnical problems by means of the finite element method implicitly involves some inevitable numerical and modeling errors. The accuracy at which reality is approximated depends highly on the expertise of the user regarding the modelling of the problem, the understanding of the soil models and their limitations, the selection of model parameters, and the ability to judge the reliability of the computational results. Hence, PLAXIS may only be used by professionals that possess the aforementioned expertise. The user must be aware of his/her responsibility when he/she uses the computational results for geotechnical design purposes. The PLAXIS organisation cannot be held responsible or liable for design errors that are based on the output of PLAXIS calculations.

Trademark

Windows® is a registered trademark of the Microsoft Corp.

Copyright PLAXIS program by:

PLAXIS bv  P.O. Box 572, 2600 AN  DELFT, Netherlands
Fax: + 31 15 257 3107; E-mail: info@plaxis.nl; Internetsite: http://www.plaxis.nl

This manual may not be reproduced, in whole or in part, by photo-copy or print or any other means, without written permission from PLAXIS bv
### TABLE OF CONTENTS

1. **Introduction** ........................................................................................................... 1-1

2. **Getting started** ........................................................................................................ 2-1
   2.1 Installation ........................................................................................................ 2-1
   2.2 General modelling aspects ............................................................................. 2-1
   2.3 Input procedures .............................................................................................. 2-3
      2.3.1 Input of Geometry objects ............................................................. 2-3
      2.3.2 Input of text and values ..................................................................... 2-3
      2.3.3 Input of selections ........................................................................... 2-4
      2.3.4 Structured input .............................................................................. 2-5
   2.4 Starting the program ...................................................................................... 2-6
      2.4.1 General settings .............................................................................. 2-6
      2.4.2 Creating a model ............................................................................. 2-8

3. **Settlement of square footing on sand (lesson 1)** ........................................... 3-1
   3.1 Geometry ....................................................................................................... 3-1
   3.2 Rigid Footing .................................................................................................. 3-2
      3.2.1 Creating the input ........................................................................... 3-2
      3.2.2 Performing calculations ............................................................... 3-15
      3.2.3 Viewing output results ................................................................. 3-21
   3.3 Flexible Footing ............................................................................................ 3-23

4. **Staged construction of NATM tunnel (lesson 2)** ............................................ 4-1
   4.1 Geometry ....................................................................................................... 4-1
   4.2 Calculations ................................................................................................... 4-9
   4.3 Viewing output results .................................................................................. 4-13

5. **Tunnel heading stability (lesson 3)** ............................................................... 5-1
   5.1 Geometry ....................................................................................................... 5-2
   5.2 Calculations ................................................................................................... 5-9
   5.3 Safety analysis .............................................................................................. 5-11
   5.4 Viewing output results .................................................................................. 5-13

6. **Stability of a diaphragm wall excavation (lesson 4)** ....................................... 6-1
   6.1 Input ............................................................................................................... 6-1
   6.2 Calculations ................................................................................................... 6-5
   6.3 Output ............................................................................................................ 6-9

**Appendix A - Menu structure**

**Appendix B - Calculation scheme for initial stresses due to soil weight**
1 INTRODUCTION

PLAXIS 3D Tunnel is a finite element package that has been developed specifically for the analysis of deformation and stability in tunnel projects. The simple graphical input procedures enable a quick generation of complex finite element models, and the enhanced output facilities provide a detailed presentation of computational results. The calculation itself is fully automated and based on robust numerical procedures.

The Introductory version can be used directly from the Demo CD or installed on hard disk for faster program operations. This version is intended to show new users most of the available options of the full program and are limited compared to the full versions:

- only one set of soil parameters can be used in each calculation;
- the number of z-planes is limited to a maximum of 5;
- the number of slices is limited to a maximum of 4;
- the number of calculation phases is limited to 5 phases;
- no print facilities are available;
- the output cannot be copied to the clipboard.

This Tutorial Manual is a simplified version of the Tutorial Manual supplied with the full version of PLAXIS 3D Tunnel, and takes the limitations of the Introductory Version into account. It is intended to help new users become familiar with PLAXIS 3D Tunnel.

The various lessons deal with a range of interesting practical applications and cover most of the program features. However, the use of soil models is limited to the basic Mohr-Coulomb model. Users are expected to have a basic understanding of soil mechanics and should be able to work in a Windows environment.

It is helpful, but not required, that users are familiar with the standard PLAXIS (2D) deformation analysis program, as many of the interface objects are similar. It is strongly recommended that the lessons are followed in the order that they appear in the manual. The tutorial lessons are also available in the examples folder of the PLAXIS 3D Tunnel Introductory program directory and can be used to check your results.

The Tutorial Manual does not provide theoretical background information on the finite element method, nor does it explain the details of the various soil models available in the program. The latter can be found in the Material Models Manual, as included in the manuals of the full version of PLAXIS 3D Tunnel, and theoretical background is given in the corresponding Scientific Manual. For detailed information on the available program features, the user is referred to the Reference Manual. The manuals are included on the Introductory CD. The latest version of the manuals can be downloaded from the PLAXIS website for free (http://www.plaxis.com).
2 GETTING STARTED

This chapter describes some of the notation and basic input procedures that are used in the PLAXIS 3D Tunnel program. In the manuals, menu items, buttons or windows specific items are printed in *Italics*. Whenever keys on the keyboard need to be pressed, this is indicated by the name of the key or button in brackets, (for example the <Enter> key).

2.1 INSTALLATION

The installation procedure of the Introductory Version is fully automated. If problems occur after the installation, the installation program can be run again to repair the program.

2.2 GENERAL MODELLING ASPECTS

For each new 3D project to be analysed it is important to create a 2D cross-section model first. A cross-section model is a 2D representation of a real three-dimensional problem and consists of points, lines and clusters. A cross-section model should include a representative division of the subsoil into distinct soil layers, structural objects, construction stages and loadings. The model must be sufficiently large so that the boundaries do not influence the results of the problem to be studied. The three types of components in a cross-section model are described below in more detail.

**Points:**
Points form the start and end of lines. Points can also be used for the positioning of anchors, point forces, point fixities and for local refinements of the finite element mesh.

**Lines:**
Lines are used to define the physical boundaries of the geometry, the model boundaries and discontinuities in the geometry such as walls or shells, separations of distinct soil layers or construction stages. A line can have several functions or properties.

**Clusters:**
Clusters are areas that are fully enclosed by lines. PLAXIS automatically recognises clusters based on the input of geometry lines. Within a cluster the soil properties are homogeneous. Hence, clusters can be regarded as parts of soil layers. Actions related to clusters apply to all elements in the cluster.

After the creation of a geometry model, a 2D finite element mesh composed of 6-node triangles can automatically be generated, based on the composition of clusters and lines in the geometry model. If the 2D mesh is satisfactory, an extension into the third
dimension can be made by specifying the z-coordinates of all vertical planes that are needed to create the three-dimensional model.

For a three-dimensional model, two further components need to be included. These are described below.

**Z-planes:**
Z-planes (also referred to simply as 'planes') are vertical cross-section planes, with different z-coordinates, that are used to create the 3D finite element model from the 2D model. Each z-plane is the same, but the distance between z-planes may vary, as defined by the input of z-coordinates. If the distance between two successive z-planes is too large, intermediate z-planes are automatically introduced during the 3D mesh generation process. Z-planes may be used to activate or deactivate point loads, line loads, z-loads or anchors, or to apply a contraction to a tunnel lining. In the Introductory Version, a maximum of five z-planes can be created.

**Slices:**
Slices are the volumes between two adjacent z-planes. Slices may be used to activate or deactivate soil volumes, plates, line loads, distributed loads, volumetric strains or water pressures. In the Introductory Version, a maximum of four slices can be created.

![15-node wedge elements](image)

In a 3D finite element mesh three types of components can be identified, as described below.

**Elements:**
During the generation of the mesh, slices are divided into 15-node wedge elements. These elements are composed of the 6-node triangular faces in the z-planes, as generated by the 2D mesh generation, and 8-node quadrilateral faces in z-direction. In addition to the volume elements, which are generally used to model the soil, compatible 8-node plate elements and 16-node interface elements may be generated to model structural behaviour and soil-structure interaction respectively.
Nodes:
The wedge elements as used in the 3D Tunnel program consist of 15 nodes. The
distribution of nodes over the elements is shown in Figure 2.1. Adjacent elements are
connected through their common nodes. During a finite element calculation,
displacements ($u_x$, $u_y$ and $u_z$) are calculated at the nodes. Nodes may be pre-selected for
the generation of load-displacement curves.

Stress points:
In contrast to displacements, stresses and strains are calculated at individual Gaussian
integration points (or stress points) rather than at the nodes. A 15-node wedge element
contains 6 stress points as indicated in Figure 2.1. Stress points may be pre-selected for
the generation of stress paths or stress-strain diagrams.

2.3 INPUT PROCEDURES

In PLAXIS, input is specified by using the mouse and also by keyboard input. In general,
four types of input may be identified:

- Input of geometry objects (e.g. drawing a soil layer)
- Input of text (e.g. entering a project name)
- Input of values (e.g. entering the soil unit weight)
- Input of selections (e.g. choosing a soil model)

The mouse is generally used for drawing and selection purposes, whereas the keyboard
is used to enter text and values.

2.3.1 INPUT OF GEOMETRY OBJECTS

The creation of a cross-section model is based on the input of points and lines. This is
done by means of a mouse pointer in the draw area. Several geometry objects are
available from the menu or from the toolbar. The input of most of the geometry objects
is based on a line drawing procedure. In any of the drawing modes, lines are drawn by
clicking on the left mouse button in the draw area. As a result, a first point is created. On
moving the mouse and left clicking with the mouse again, a new point is created
together with a line from the previous point to the new point. The line drawing is
finished by clicking the right mouse button, or by pressing the <Esc> key on the
keyboard.

2.3.2 INPUT OF TEXT AND VALUES

As for any software, some input of values and text is required. The required input is
specified in the edit boxes. Multiple edit boxes for a specific subject are grouped in
windows. The desired text or value can be typed on the keyboard, followed by the
<Enter> key or the <Tab> key. As a result, the value is accepted and the next input field
is highlighted. In some countries, like The Netherlands, the decimal dot in floating point values is represented by a comma. The type of representation that occurs in edit boxes and tables depends on the country setting of the operating system. Input of values must be given in accordance with this setting.

Many parameters have default values. These default values may be used by pressing the <Enter> key without other keyboard input. In this manner, all input fields in a window can be entered until the OK button is reached. Pressing the OK button confirms all values and closes the window. Alternatively, selection of another input field, using the mouse, will result in the new input value being accepted. Input values are confirmed by left clicking the OK button with the mouse. Pressing the <Esc> key or left clicking the Cancel button will cancel the input and restore the previous or default values before closing the window.

The spin edit feature is shown in Figure 2.2. Just like a normal input field a value can be entered by means of the keyboard, but it is also possible to left-click the ø or ø arrows at the right side of each spin edit to increase or decrease its value by a predefined amount.

![Figure 2.2 Spin edits](image)

### 2.3.3 INPUT OF SELECTIONS

Selections are made by means of radio buttons, check boxes or combo boxes as described below.

![Figure 2.3 Radio buttons](image)

![Figure 2.4 Check boxes](image)
Radio buttons:
In a window with radio buttons only one item may be active. The active selection is indicated by a black dot in the white circle in front of the item. Selection is made by clicking the left mouse button in the white circle or by using the up and down arrow keys on the keyboard. When changing the existing selection to one of the other options, the 'old' selection will be deselected. An example of a window with radio buttons is shown in Figure 2.3. According to the selection in Figure 2.3 the Global pore pressure distribution parameter is set to General phreatic level.

Check boxes:
In a window with check boxes more than one item may be selected at the same time. The selection is indicated by a black tick mark in a white square. Selection is made by clicking the left mouse button in the white square or by pressing the space bar on the keyboard. Another click a preselected item will deselect the item. An example of three check boxes is shown in Figure 2.4.

Combo boxes:
A combo box is used to choose one item from a predefined list of possible choices. An example of a window with combo boxes is shown in Figure 2.5. As soon as the \( \rightarrow \) arrow at the right hand side of the combo box is left clicked with the mouse, a pull down list occurs that shows the possible choices. A combo box has the same functionality as a group of radio buttons but it is more compact.

2.3.4 STRUCTURED INPUT
The required input is organised in a way to make it as logical as possible. The Windows environment provides several ways of visually organising and presenting information on the screen. To make the reference to typical Windows elements in the next chapters easier, some types of structured input are described below.

Page control and tab sheets:
An example of a page control with three tab sheets is shown in Figure 2.6. In this figure the second tab sheet for the input of the model parameters of the Mohr-Coulomb soil model is active. Tab sheets are used to handle large amounts of different types of data.
which do not all fit in one window. Tab sheets can be activated by left-clicking on the corresponding tab or using <Ctrl><Tab> on the keyboard.

**Group boxes:**
Group boxes are rectangular boxes with a title. They are used to cluster input items that have common features. In Figure 2.6, the active tab sheet contains three group boxes named *Stiffness*, *Strength* and *Alternatives*.

![Figure 2.6 Page control and tab sheets](image)

2.4 **STARTING THE PROGRAM**

It is assumed that the program has been installed using the procedures described in the General Information part of the manual. It is advisable to create a separate directory in which data files are stored. The PLAXIS 3D Tunnel Introductory program can be started by double-clicking on the *Plaxis 3D input* icon in the PLAXIS 3D Tunnel Introductory program group. The user is asked whether to define a new problem or to retrieve a previously defined project. If the latter option is chosen, the program lists four of the most recently used projects from which a direct choice can be made. Choosing the item <<more files>> that appears first in this list will give a file requester from which the user can choose any previously defined project for modification.

2.4.1 **GENERAL SETTINGS**

If a new project is to be defined, the *General settings* window as shown in Figure 2.7 appears. This window consists of two tab sheets. In the first tab sheet miscellaneous settings for the current project have to be given. A filename has not been specified here; this can be done when saving the project.
GETTING STARTED

The user can enter a brief description of the problem as the title of the project as well as a more extended description in the Comments box. The title is used as a proposed filename and appears on output plots. The comments box is simply a convenient place to store information about the analysis. In addition, a parameter named Declination can be specified, which is only required when using the Jointed Rock model.

Figure 2.7 General settings - General tab sheet

The second tab sheet is shown in Figure 2.8. In addition to the basic units of Length, Force and Time, the minimum dimensions of the draw area must be given here, such that the geometry model will fit the draw area.

Figure 2.8 General settings - Dimensions tab sheet
The general system of axes is such that the $x$-axis points to the right, the $y$-axis points upward and the $z$-axis points towards the user. *Left* is the lowest $x$-coordinate of model, *Right* the highest $x$-coordinate, *Bottom* the lowest $y$-coordinate and *Top* the highest $y$-coordinate of the model. The range of $z$-coordinates is defined later. The *Declination* parameter on the Project tab sheet is used to relate the $z$-direction to the geographical North direction. However, this parameter is only required for the Jointed Rock model.

In practice, the draw area resulting from the given values will be larger than the values given in the four spin edits. This is partly because PLAXIS will automatically add a small margin to the dimensions and partly because of the difference in the width/height ratio between the specified values and the screen.

### 2.4.2 CREATING A MODEL

When the general settings are entered and the *OK* button is clicked, the main window appears. This main window is shown in Figure 2.9. The most important parts of the main window are indicated and briefly discussed below.

![Figure 2.9 Main window of the Input program](image)

**Main menu:**

The main menu contains all the options that are available from the toolbars, and some additional options that are not frequently used.
**Tool bar (General):**
This tool bar contains buttons for general actions like disk operations, printing, zooming or selecting objects. It also contains buttons to start the other programs of the 3D Tunnel package (Calculations, Output and Curves).

**Tool bar (Geometry):**
This tool bar contains buttons for actions that are related to the creation of a cross-section model or a fully 3D finite element model. The buttons are ordered in such a way that, in general, following the buttons on the tool bar from the left to the right results in a completed model.

**Rulers:**
At both the left and the top of the draw area, rulers indicate the physical coordinates, which enables a direct view of the geometry dimensions.

**Draw area:**
The draw area is the drawing sheet on which the cross-section model is created. The draw area can be used in the same way as a conventional drawing program. The grid of small dots in the draw area can be used to snap to regular positions.

**Origin:**
If the physical origin is within the range of given dimensions, it is represented by a small circle, with an indication of the x- and y-axes.

**Manual input:**
If drawing with the mouse does not give the desired accuracy, then the Manual input line can be used. Values for x- and y-coordinates can be entered here by typing the corresponding values separated by a space. The manual input can also be used to assign new coordinates to a selected point.

**Cursor position indicator:**
The cursor position indicator gives the current position of the mouse cursor both in physical units and screen pixels. Some of the objects mentioned above can be removed by deselecting the corresponding item from the View menu.

**Toolbars**
For both toolbars, the name and function of the buttons is shown after positioning the mouse cursor on the corresponding button and keeping the mouse cursor still for about a second; a hint will appear in a small yellow box below the button. The available hints
for both toolbars are shown in Figure 2.10. In this Tutorial Manual, buttons will be referred to by their corresponding hints.

Figure 2.10  Toolbars

For detailed information on the creation of a complete finite element model, the reader is referred to the various lessons that are described in this Tutorial Manual.
3 SETTLEMENT OF SQUARE FOOTING ON SAND (LESSON 1)

In the previous chapter some general aspects and basic features of the PLAXIS 3D Tunnel Introductory program were presented. In this chapter a first application is considered, namely the settlement of a square foundation footing on sand. This is the first step in becoming familiar with the practical use of the program. The general procedures for the creation of a cross-section model, the generation of a finite element model in 2D and 3D, the execution of a finite element calculation and the evaluation of the output results are described here in detail. The information provided in this chapter will be utilised in the later lessons. Therefore, it is important to complete this first lesson before attempting any further tutorial examples.

3.1 GEOMETRY

A square footing with a width of 1.8 m is placed on a sand layer of 4.0 m thickness as shown in Figure 3.1. Under the sand layer there is a stiff rock layer that extends to a large depth. The purpose of the exercise is to find the displacements and stresses in the soil caused by the load applied to the footing. Calculations are performed for both rigid
and flexible footings. The geometry of the finite element model for these two situations is similar. The rock layer is not included in the model; instead, an appropriate boundary condition is applied at the bottom of the sand layer. To reduce calculation time, only one-quarter of the footing is modelled, using symmetry boundary conditions along the lines of symmetry. To enable any possible mechanism in the sand and to avoid any influence of the outer boundary, the model is extended in both horizontal directions to a total width of 5.0 m.

3.2 RIGID FOOTING

In the first calculation, the footing is modelled as being very stiff and rough. In this case the settlement of the footing is simulated by means of a uniform indentation at the top of the sand layer, instead of modelling the footing itself. This approach leads to a relatively simple model and is therefore used as a first exercise. However, it does have some disadvantages. For example, it does not give any information about the structural forces in the footing. The second part of this lesson deals with an external load on a flexible footing, which is a more advanced modelling approach.

3.2.1 CREATING THE INPUT

Start PLAXIS 3D Tunnel by double-clicking the icon of the 3D Input program. A Create/Open project dialog box will appear in which you can select an existing project or create a new one. Choose a New project and click the OK button. Now the General settings window appears, consisting of the two tab sheets Project and Dimensions (Figure 3.3 and Figure 3.4).

![Create/Open project dialog box](image)

Figure 3.2 Create/Open project dialog box

**General Settings**

The first step in every analysis is to specify the basic parameters of the finite element model. This is done in the General settings window. These settings include the
description of the problem, the model orientation, the basic units and the size of the draw area.

To enter the appropriate settings for the footing calculation, follow these steps:

- In the **Project** tab sheet, enter “Lesson 1” in the **Title** box and type “Settlements of a square footing” in the **Comments** box.
- In the **General** box the type of the analysis (**Model**) and the basic element type (**Elements**) are specified. These are specified to be **3D parallel planes** and **15-node wedge** respectively.

![General settings](image)

**Figure 3.3** Project tab sheet of the General settings window

- The **Acceleration** box indicates a fixed gravity angle of -90°, which is in the vertical direction (downward).
- The **Model orientation** box shows a default **declination** of 0°, which means that the North direction coincides with the negative z-direction. However, the declination parameter is only of interest if the Jointed Rock model is used, which is not the case in this lesson. Click the **Next** button below the tab sheets or click the **Dimensions** tab.
- In the **Dimensions** tab sheet, keep the default units in the **Units** box (Unit of **Length** = m; Unit of **Force** = kN; Unit of **Time** = day).
- In the **Geometry dimensions** box the size of the required draw area must be entered. When entering the upper and lower coordinate values of the geometry to be created, a small margin is automatically added so that the geometry will fit well within the draw area. Enter 0.0, 5.0, 0.0 and 4.0 in the **Left**, **Right**, **Bottom** and **Top** edit boxes respectively.
The *Grid* box contains values to set the grid spacing. The grid provides a matrix of dots on the screen that can be used as reference points. It may also be used for snapping to regular points during the creation of the geometry. The distance between the dots is determined by the *Spacing* value. The spacing of snapping points can be further divided into smaller intervals by the *Number of intervals* value. Enter 1.0 for the spacing and 10 for the intervals.

Click the *OK* button to confirm the settings. Now the draw area appears in which the cross-section model can be drawn.

![General settings window](image)

**Figure 3.4** *Dimensions* tab sheet of the *General settings* window

**Hint:** In the case of a mistake or for any other reason that the general settings need to be changed, you can access the *General settings* window by selecting the *General settings* option from the *File* menu.

**Geometry Contour**

Once the general settings have been completed, the draw area appears with an indication of the origin and direction of the system of axes. The *x*-axis is pointing to the right and the *y*-axis is pointing upward. The *z*-direction is perpendicular to the draw area, pointing towards the user. A 2D cross-section model can be created anywhere within the draw area. The extension into the *z*-direction is considered later. To create objects, one can either use the buttons from the toolbar or the options from the *Geometry* menu. For a new project, the *Geometry line* button is already active. Otherwise this option can be selected from the first button block with geometry objects in the toolbar or from the *Geometry* menu. To construct the contour of the proposed geometry, follow these steps:
Select the *Geometry line* option (already pre-selected).

- Position the cursor (now appearing as a pen) at the origin of the axes. Check that the units in the status bar read 0.0 x 0.0 and click the left mouse button once. The first geometry point (number 0) has now been created.
- Move along the *x*-axis to position (5.0; 0.0). Click the left mouse button to generate the second point (number 1). At the same time the first geometry line is automatically created from point 0 to point 1.
- Move upward to position (5.0; 4.0) and click again.
- Move to the left to position (0.0; 4.0) and click again.
- Finally, move back to the origin (0.0; 0.0) and click the left mouse button again. Since this final point already exists, no new point is created, but an additional geometry line is created from point 3 to point 0. The program will also detect a cluster (area that is fully enclosed by geometry lines) and will give it a light colour.
- Click the right mouse button to stop drawing.

**Hint:** Mispositioned points and lines can be modified or deleted by first choosing the *Selection* button from the toolbar. To move a point or line, select the point or the line and drag it to the desired position. To delete a point or a line, select the point or the line and click the *Delete* button on the keyboard.

> Unwanted drawing operations can be removed by pressing the *Undo* button from the toolbar or by selecting the *Undo* option from the *Edit* menu or by pressing `<Ctrl><Z>` on the keyboard.

> Lines can be drawn perfectly horizontal or vertical by holding down the `<Shift>` key on the keyboard while moving the cursor.

The proposed geometry does not include plates, geogrids, interfaces, anchors or tunnels. Hence, you can skip the remaining buttons of the first button block in the toolbar.

**Hint:** The full cross-section model has to be completed before a finite element mesh can be generated. This means that boundary conditions and model parameters must be entered and applied to the model before proceeding.

**Boundary Conditions**

Boundary conditions can be found in the second block of the toolbar and in the *Loads* menu. For deformation problems two types of boundary conditions exist: prescribed displacements and prescribed forces (loads). In principle, all boundaries must have one boundary condition in each direction. When no explicit boundary condition is given to a
certain boundary, the natural condition applies, which is a prescribed force equal to zero and a free displacement.

To avoid the situation where the displacements of the geometry are undetermined, some points of the geometry must have prescribed displacements. The simplest form of a prescribed displacement is a fixity (zero displacement), but non-zero prescribed displacements may also be specified. In this problem, the settlement of the rigid footing is simulated by means of non-zero prescribed displacements at the top of the sand layer.

To create the boundary conditions for this lesson, follow these steps:

1. Click the **Standard fixities** button on the toolbar or choose the **Standard fixities** option from the **Loads** menu to set the standard boundary conditions.

As a result, **PLAXIS** will generate a full fixity at the base of the geometry and roller conditions at the vertical sides \((u_x=0; u_y=\text{free})\). Later in the full 3D model, fixities in the \(z\)-direction are taken equal to the fixities in the \(x\)-direction, whereas the front and end planes are always fixed in the \(z\)-direction. An \(x\)- or \(y\)-fixity appears on the screen as two parallel lines perpendicular to the fixed direction. Hence, roller supports appear as two vertical parallel lines and full fixities appear as cross-hatched lines.

**Hint:** The **Standard fixities** option is suitable for most geotechnical applications. It is a fast and convenient way to input standard boundary conditions.

2. Select the **Prescribed displacements** button from the toolbar or select the corresponding option from the **Loads** menu.

3. Move the cursor to point (0.0; 4.0) and click the left mouse button.

4. Move along the upper geometry line to point (0.9; 4.0) and click the left mouse button again.

5. Click the right button to stop drawing.

In addition to the new point (4), a prescribed downwards displacement of 1 unit (-1.0 m) in a vertical direction and a prescribed displacement of zero in horizontal direction (corresponding to horizontal fixity) is created at the upper left side of the geometry. The prescribed displacement is set to an arbitrary input value; the actual value that has to be applied can be specified when defining a calculation (Section 3.2.2). Prescribed displacements appear as a series of arrows starting from the geometry line and pointing in the direction of movement.

**Hint:** The input value of a prescribed displacement may be changed by first clicking on the **Selection** button and then double-clicking on the line at which a prescribed displacement is applied. On selecting **Prescribed displacements** from the **Select** dialog box, a new window will appear in which the changes can be made. In this way it is also possible to release the displacements in one direction while the displacements in the other directions are prescribed.
Other types of loading are not considered in this lesson, so the remaining buttons in the second button block in the toolbar can be skipped.

**Material data sets**

To simulate the behaviour of the soil, a suitable soil model and appropriate material parameters must be assigned to the geometry. In all PLAXIS programs, soil properties are collected in material data sets and the various data sets are stored in a material database. From the database, a data set can be assigned to one or more clusters. For structures (like walls, plates, anchors, geogrids, etc.) the system is similar, but different types of structures have different parameters and therefore different types of data sets. Distinction is made between material data sets for *Soil & Interfaces*, *Plates*, *Anchors* and *Geogrids*.

The creation of material data sets is generally done after the input of boundary conditions. Before the mesh is generated, all material data sets should have been defined and all clusters and structures must have an appropriate data set assigned to them.

The input of material data sets can be selected by means of the *Material Sets* button on the toolbar or from the options available in the *Materials* menu.
Table 3.1  Material properties of the sand layer

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td></td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td></td>
</tr>
<tr>
<td>Unit weight of soil above phreatic level</td>
<td>γunsat</td>
<td>17.0</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Unit weight of soil below phreatic level</td>
<td>γsat</td>
<td>20.0</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Permeability</td>
<td>kₓ, kᵧ, kₑ</td>
<td>1.0</td>
<td>m/day</td>
</tr>
<tr>
<td>Young's modulus (constant)</td>
<td>Eref</td>
<td>1.3·10⁴</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>ν</td>
<td>0.3</td>
<td></td>
</tr>
<tr>
<td>Cohesion (constant)</td>
<td>cref</td>
<td>1.0</td>
<td></td>
</tr>
<tr>
<td>Friction angle</td>
<td>φ</td>
<td>31.0</td>
<td></td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>ψ</td>
<td>0.0</td>
<td></td>
</tr>
</tbody>
</table>

To create a material set for the sand layer, follow these steps:

- Select the Material Sets button on the toolbar.
- Select the material data set and click the Edit button at the lower side of the Material Sets window. A dialog box will appear with three tab sheets: General, Parameters and Interfaces (Figure 3.6 and Figure 3.7).

![Material Set Window](image)

Figure 3.6  General tab sheet of the soil and interface data set window

- In the Material Set box of the General tab sheet, write “Sand” in the Identification box.
• Select Mohr-Coulomb from the Material model combo box and Drained from the Material type combo box (default parameters).

• Enter the unit weights in the General properties box according to the material data as listed in Table 3.1. Also enter the permeabilities as listed. For this example a uniform permeability is modelled.

![Parameters tab sheet of the soil and interface data set window](image)

Figure 3.7 Parameters tab sheet of the soil and interface data set window

• Click the Next button or click the Parameters tab to proceed with the input of model parameters. The parameters appearing on the Parameters tab sheet depend on the selected material model (in this case the Mohr-Coulomb model). The Mohr-Coulomb model involves only five basic parameters (E, ν, c, φ, ψ).

See the Material Models manual for a detailed description of different soil models and their corresponding parameters.

• Enter the model parameters (Table 3.1) in the corresponding edit boxes of the Parameters tab sheet.

• Since the geometry model does not include interfaces, the third tab sheet can be skipped. Click the OK button to confirm the input of the current material data set. Now the created data set will appear in the tree view of the Material Sets window.

• Drag the data set “Sand” from the Material Sets window (select it and keep the left mouse button down while moving) to the soil cluster in the draw area and drop it there (release the left mouse button). Notice that the cursor changes shape to indicate whether or not it is possible to drop the data set. Correct assignment of a data set to a cluster is indicated by a change in colour of the cluster.
• Click the OK button in the Material Sets window to close the database.

**Hint:** PLAXIS distinguishes between a project database and a global database of material sets. In the Introductory version the global data base is not available. In the Professional version data sets may be exchanged from one project to another using the global database.

> Existing data sets may be changed by opening the material sets window, selecting the data set to be changed from the tree view and clicking on the Edit button. As an alternative, the material sets window can be opened by double-clicking a cluster and clicking on the Change button behind the Material set box in the properties window. A data set can now be assigned to the corresponding cluster by selecting it from the project database tree view and clicking on the Apply button.

> The program performs a consistency check on the material parameters and will give a warning message in the case of a detected inconsistency in the data. The global database is not available in the Introductory Version.

### 2D Mesh Generation

When the cross-section model is complete, a 2D finite element mesh must be generated before the extension into the z-direction is considered. The program allows for a fully automatic mesh generation procedure, in which the geometry is divided into volume elements and compatible structural elements, if applicable. The mesh generation takes full account of the position of points and lines in the geometry model, so that the exact position of layers, loads and structures is accounted for in the finite element mesh. The 2D mesh generation process is based on a robust triangulation principle that searches for optimised triangles and which results in an unstructured mesh. Although unstructured meshes do not form regular patterns of elements, the numerical performance of these meshes is usually better than structured meshes with regular arrays of elements. In addition to the mesh generation itself, a transformation of input data (properties, boundary conditions, material sets, etc.) from the geometry model (points, lines and clusters) to the finite element mesh (elements, nodes and stress points) is made.

To generate the mesh, follow these steps:

1. Click the Generate mesh button in the toolbar or select the Generate option from the Mesh menu. After the generation of the mesh a new window is opened (Output window) in which the generated mesh is presented (Figure 3.8).

2. Click the Update button to return to the geometry input mode.

3. Large displacement gradients are expected under the footing. Hence, it is appropriate to have a finer mesh under the footing. Click the upper line of the prescribed displacement representing the footing (single click). The selected prescribed displacement is now indicated in red. From the Mesh menu, select the option Refine line. As a result, a local refinement of the indicated line is visible in the presented mesh. Click the Update button to return.
If necessary, the mesh can be further optimised by performing global or local refinements. These mesh refinements are considered in some of the later lessons. Here it is suggested that the current finite element mesh is accepted.

**Figure 3.8 2D finite element mesh of the geometry around the footing**

**Hint:** By default, the *Global coarseness* of the mesh is set to *Very Coarse*, which is adequate as a first approach in most cases. The *Global coarseness* setting can be changed in the *Mesh* menu. In addition, options are available to refine the mesh globally or locally.

> At this stage of input it is still possible to modify parts of the geometry or to add geometry objects. If modifications are made at this stage, then the finite element mesh has to be regenerated.

**3D Mesh Generation**

After generation of the 2D mesh, the model must be extended to a fully 3D mesh. This can be done by clicking on the 3D mesh generation button or selecting the corresponding option from the *Mesh* sub-menu. As a result, a new window will appear in which the positions (*z*-coordinates) of particular *z*-planes can be specified (Figure 3.9). The previously generated 2D mesh is repeated at each *z*-plane. Two adjacent *z*-planes form a slice. The 3D mesh is created by connecting the corners of the 2D triangular elements to the corresponding points of the corresponding elements in the...
next z-plane. In this way, a 3D mesh composed of 15-node wedge elements is created. For more details see 3.6.6. of the Reference Manual.

A z-plane is needed wherever a discontinuity in the geometry or in the loading occurs in the initial situation or in the construction process. If necessary, slices are automatically divided into sub-slices, so that the size of the elements in the z-direction is about equal to the average element size defined for the 2D mesh generation.

![Image](image.png)

Figure 3.9 Positions (z-coordinates) of particular z-planes

In this lesson we model a quarter of the foundation (0.9 by 0.9 m.) in a geometry of 5.0 by 5.0 m. The quarter of the foundation extends 0.9 m in the z-direction, hence a discontinuity in the geometry exists and a z-plane is needed. The front plane is set at 0.0 m and the rear plane at –5.0 m.

To generate the 3D mesh, follow these steps:

- Click the Generate 3D mesh button in the toolbar or select the Generate 3D mesh option from the Mesh menu. A new window will appear in which the positions (z-coordinates) of all z-planes can be specified (Figure 3.9).

- Since the model extends horizontally, the slope in the z-direction is zero. The original cross-section model is taken at position z = 0.0, indicated as ‘rear plane’. However, we will extend the model backwards (into the negative z-direction) to comply with the quarter of the full model as indicated in Figure 3.1. When the rear plane (0.0) is selected, press the Insert button. As a result, a new (rear) plane is introduced at z = -1.0, whereas the original plane has become the front plane.

- Change the z-coordinate of the rear plane into –5.0 and press <Enter>. The front plane will be highlighted. Press again the Insert button. A new plane (A) is introduced halfway between the rear plane and the front plane. Change the z-coordinate of plane A into –0.9.
If the distance between two adjacent planes is significantly larger than the average (2D) element size, the 3D mesh generation procedure will automatically generate Sub-planes (Figure 3.10) to avoid badly shaped elements.

There is a way to create elements automatically with a larger or smaller size in z-direction by assigning a local element size factor to a plane. This can be achieved by clicking on the selected plane (horizontal line) in the top view of the 3D mesh generation window. As a result, a new window appears in which the local element size factor can be entered. This local element size factor determines the position of the sub-slices and thus the size of the 3D elements in the z-direction in the 3D mesh generation procedure.

Click the Generate button. The 3D mesh generation procedure is started and the 3D mesh is displayed in the Output window. Sub-planes were automatically introduced between plane A and the rear plane to reduce the element size in the z-direction. The total number of 3D wedge elements is equal to the product of the number of 2D triangular elements in the 2D mesh and the total number of slices. The 3D mesh and its various z-planes can be viewed by moving through the tab sheets in the Output program. The arrow keys of the keyboard allow the
user to rotate the model so that it can be viewed from any direction (Figure 3.10).

- Click the *Update* button to return to the geometry input mode.

**Initial Conditions**

Once the mesh has been generated, the finite element model is complete. Before starting the calculations, however, the initial conditions must be generated. In general, the initial conditions comprise the initial water conditions, the initial geometry configuration and the initial effective stress state. The sand layer in the current footing project is dry, so there is no need to enter water conditions. The analysis does, however, require the generation of initial effective stresses by means of the $K_0$-procedure.

The initial conditions are entered in separate modes of the Input program. To generate the initial conditions properly, follow these steps:

- Click the *Initial conditions* button on the toolbar or select the *Initial conditions* option from the *Initial* menu.

- A small window appears showing the default value of the unit weight of water, which is 10 (kN/m$^3$). Click **OK** to accept the default value, after which the water conditions mode appears. Note that the toolbar and the background of the geometry have changed compared to the geometry input mode.

The initial conditions option consists of two different modes: the water pressures mode and the geometry configuration mode. Switching between these two modes is done by the 'switch' in the toolbar.

- Since the current project does not involve water pressures, proceed to the geometry configuration mode by clicking on the right hand side of the 'switch' (*Initial stresses and geometry configuration*). Note that the prescribed displacement is deactivated (grey colour).

- Click the *Generate initial stresses* button (shown by the red crosses) in the toolbar or select the *Initial stresses* option from the *Generate* menu. The $K_0$-procedure window appears.

- Keep the total multiplier for soil weight, $\Sigma M_{\text{weight}}$, equal to 1.0. This means that the full weight of the soil is applied for the generation of initial stresses. Accept the default values of $K_0$ and click the **OK** button.

**Hint:** The $K_0$-procedure may only be used for horizontally layered geometries with a horizontal ground surface and, if applicable, a horizontal phreatic level. See the Reference Manual for more information on the $K_0$-procedure.

$>$ The default value of $K_0$ is based on Jaky's formula: $K_0 = 1 - \sin \varphi$. If the input value is changed, the default value can be regained by entering a negative value for $K_0$. 

3-14 PLAXIS 3D Tunnel Introductory version
• After the generation of the initial stresses, the Output window is opened in which the effective stresses are presented (Figure 3.11). Click the Update button to return to the geometry configuration mode of the Input program.

After the generation of the initial stresses, the calculation can be defined. By clicking on the Calculate button, the user is invited to save the data on the hard disk. Click the Yes button. The file requester now appears. Enter an appropriate file name and click the Save button.

![Image](image.png)

Figure 3.11 Initial stresses in the geometry

### 3.2.2 PERFORMING CALCULATIONS

After clicking on the Calculate button and saving the input data, the Input program is closed and the Calculations program is started. The Calculations program may be used to define and execute calculation phases. It can also be used to select calculated phases for which output results are to be viewed.

The Calculations window consists of a menu, a toolbar, a set of tab sheets and a list of calculation phases, as indicated in Figure 3.12. The tab sheets (General, Parameters and Multipliers) are used to define a calculation phase. All defined calculation phases appear in the list at the lower part of the window.
Hint: If the list of calculation phases is too short or not visible at all, the window can be enlarged by dragging down the bottom of the window.

Figure 3.12 The Calculations window with the General tab sheet

To simulate a settlement of the footing of 0.1 m, a single calculation phase is required. As in all PLAXIS programs, the 3D Tunnel program has convenient procedures for automatic load stepping (total and incremental multiplier) and for the activation and deactivation of loads and geometry parts (Staged construction). These procedures can be used for many practical applications. Staged construction is a very useful type of loading input. In this special PLAXIS feature it is possible to change the geometry and load configuration by deactivating or reactivating loads, volume clusters or structural objects as created in the geometry input. This can be done for each slice individually. Staged construction provides an accurate and realistic simulation of various loading, construction and excavation processes. The option can also be used to reassign material data sets or to change the water pressure distribution in the geometry.

In the calculation, the prescribed displacements are activated at the first slice only. To define the calculation phase, follow these steps:

- Select the first calculation phase and check if it is active (blue arrow in front of phase). Double clicking a calculation phase activates or deactivates it.
• In the General tab sheet, select 3D Plastic analysis from the combo box of the Calculation type box.

• In the Phase box write (optionally) an appropriate name for the current calculation phase (for example “Loading”) and select the phase from which the current phase should start (in this case the calculation can only start from phase 0 - Initial phase, which contains the initial stress state).

• Click the Parameters button or click the Parameters tab.

• The Parameters tab sheet contains the calculation control parameters, as indicated in Figure 3.13. Keep the default settings in the Control parameters box (Additional steps = 250) and select the Standard setting from the Iterative procedure box. See the Reference Manual for more information about the calculation control parameters.

• From the Loading input box select Staged construction.

• Click the Define button to enter the Staged construction mode.

Figure 3.13 The Calculations window with the Parameters tab sheet

• In the Staged Construction window select the tab of slice 1.

• To activate the prescribed displacement in slice 1, the corresponding geometry line may be single clicked. However, during creation of the model the prescribed displacement was automatically set to –1.0 in y-direction (default
value). In this calculation we want to arrive at a displacement of –0.1 m. only. Therefore the prescribed displacement must be double-clicked, after which the prescribed displacement input window appears (Figure 3.14).

**Hint:** The *Staged construction* window is similar to the *Initial conditions* window of the Input program. The main difference between *Initial conditions* and *Staged construction* is that the former is used to create an initial situation, whereas the latter is used as a type of loading.

> Another important difference is that in *Staged construction*, tab sheets are available for each slice and plane. This is not the case in *Initial conditions*.
> To view the position of the selected plane or slice in the model, the *Top view* option may be selected from the *View* menu. The top view is interactive, which means that individual slices or planes may also be selected by clicking on them in the top view.

**Figure 3.14** The *Prescribed displacement* window

- Enter –0.1 for the y-value of all listed geometry points (you may use the option *Displacement is constant over slice*). Make sure that none of the directions are free in the *Free directions* group. Close the window with the *OK* button.
- When the construction stage is fully defined, a 3D view of the situation can be presented by pressing the *Preview* button. This enables a direct visual check before the calculation is started. The preview should show the prescribed displacements on the upper left front corner of the 3D model. If the prescribed displacements are not visible, make sure that the *Prescribed displacements* option is selected from the *Geometry* menu.
After the preview, press the Update button to return to the Staged construction mode. If the situation is satisfactory, press the Update button to return to the Calculation program.

The calculation definition is now complete. Before starting the first calculation it is advisable to select nodes or stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this, follow these steps:

- Click the Set points for curves button on the toolbar. As a result, a window is opened, showing all the nodes in the finite element model plane wise.
- Select the node in the Front Plane at the top left corner. The selected node will be indicated by 'A'. Click the Update button to return to the Calculations window.
- Make sure only the first calculation phase is active (blue arrow before phase). Double clicking a calculation phase activates or deactivates it.
- In the Calculations window, select the first phase and click the Calculate button. All calculation phases that are selected for execution, as indicated by the blue arrow (→) (only one phase in this case) will, in principle, be executed in the order controlled by the Start from phase parameter.

**Hint:** The Calculate button is only visible if a calculation phase that is selected for execution is highlighted in the list.

- First, a small window appears showing an estimate for the calculation time of a single calculation step using the mesh. This estimate is made on the assumption that all data for the calculation fits into the (physical) memory of the computer. If virtual memory is used, and as a result a lot of hard disk swapping is necessary, the calculation time will be significantly longer than the estimate. Click OK to proceed.

![Figure 3.15 Estimate of calculation time](image)

During the execution of a calculation a window appears which gives information about the progress of the actual calculation phase (Figure 3.16). The information, which is continuously updated, comprises a load-displacement curve, the level of the load systems (in terms of total multipliers) and the progress of the iteration process (iteration number, global error, plastic points, etc.). During a staged construction calculation a
total load Multiplier \( \Sigma M_{\text{stage}} \) is increased from 0.0 to 1.0. See the Reference Manual for more information about the calculations information window and the meaning of load multipliers.

When a calculation ends, the list of calculation phases is updated and a message appears in the corresponding Log info memo box. The Log info memo box indicates whether or not the calculation has finished successfully. The current calculation should give the message 'Prescribed ultimate state fully reached'.

![Figure 3.16 The calculations information window](image)

**Hint:** Check the list of calculation phases carefully after each execution of a (series of) calculation(s). A successful calculation is indicated in the list with a green tick mark (\( \checkmark \)) whereas an unsuccessful calculation is indicated with a red cross (\( \times \)). Calculation phases that are selected for execution are indicated by a blue arrow (\( \rightarrow \)).

When a calculation phase that is highlighted is indicated by a green tick mark or a red cross, the toolbar shows the Output button, which gives direct access to the Output program. When a calculation phase that is highlighted is indicated by a blue arrow, the toolbar shows the Calculate button.

When prescribed displacements are applied the total reaction force resulting from the prescribed displacement is calculated and shown as a result. To check the reaction force at the end of the calculation, click the Multipliers tab and select the Reached values radio button. For the current application the value of Force-y is relevant. This value represents the total reaction force corresponding to the applied prescribed vertical displacement, which corresponds to the total force on one-quarter of the footing. In order to obtain the total footing force, the value of Force-y should be multiplied by four (this gives a value of about 1200 kN). It can also be seen that the \( \Sigma M_{\text{stage}} \) parameter has reached the value 1.0, which indicates that the construction stage has been completed.
### 3.2.3 VIEWING OUTPUT RESULTS

Once the calculation has been completed, the results can be evaluated in the Output program. In the Output window one can view the displacements and stresses in the full 3D geometry as well as in \(z\)-planes and in structural elements, if applicable. The computational results are also available in tabulated form. To view the results of the footing analysis, follow these steps:

- Click the executed calculation phase in the Calculations window. In addition, click the Output button in the toolbar. As a result, the Output program is started, showing the 3D deformed mesh at the end of the selected calculation phase, with an indication of the maximum displacement (Figure 3.17). The deformations are scaled to ensure that they are clearly visible.

![Figure 3.17 Deformed mesh](image)

**Hint:** The arrow keys (←↑→↓) may be used to change the orientation of a 3D model on the screen. By default, the orientation is such that the positive \(x\)-direction is to the right, the positive \(y\)-direction is upwards and the positive \(z\)-direction points towards the user. The ← and → keys may be used to rotate the model around the \(y\)-axis whereas the ↑ and ↓ keys may be used to rotate the model in its current orientation around the horizontal screen axis (out of the \(x,z\)-plane).
• Select *Total displacements* from the *Deformations* menu. The plot shows the total displacements of all nodes as arrows, with an indication of their relative magnitude.

• The presentation combo box in the toolbar currently reads *Arrows*. Select *Shadings* from this combo box. The plot shows colour shadings of the total displacements. An index is presented with the displacement values at the colour boundaries.

• Select *Contour lines* from the presentation combo box in the toolbar. The plot shows contour lines of the total displacements. An index is presented with the displacement values corresponding to the labels.

• Select the front plane (first tab). The plot now shows a scan line with labels corresponding to the index. This scan line with labels is available for all planes. The position of the scan line may be changed by using the *Scan line* option from the *Edit* menu.

**Hint:** In addition to the total displacements, the *Deformations* menu allows for the presentation of *Total Increments*. The incremental displacements are the displacements that occurred in one calculation step (in this case the final step). Incremental displacements may be helpful in visualising failure mechanisms. It is also possible to display the *Phase displacements*, which are the displacements that occurred in the last calculation phase. In the case of only one calculation phase, the total displacements and the phase displacements are the same.

• When the front plane is active, select *Effective stresses* from the *Stresses* menu. The plot shows the effective stresses as principal stresses in the front plane, with an indication of their direction and their relative magnitude (Figure 3.18).

**Hint:** The plots of stresses and displacements may be combined with geometrical features, as available in the *Geometry* menu.

Click the *Table* button on the toolbar. A new window is opened in which a table is presented, showing the values of the Cartesian stresses in each stress point of all elements.
Figure 3.18 Effective shown as principal stresses

3.3 FLEXIBLE FOOTING

The calculation is now modified so that the footing is modelled as a flexible plate. This allows the calculation of structural forces in the footing. The geometry used in this exercise is the same as the previous one, except that additional elements are used to model the footing. The calculation itself is based on the application of a load rather than prescribed displacements. It is not necessary to create a new model; you can start from the previous model, modify it and then store it under a different name. To carry out this analysis, follow the steps given below:

Modifying the geometry

Click the Go to Input button at the left hand side of the toolbar.

- Select the previous file (“lesson1” or the particular name that it was given) from the Create/Open project window.
- Select the Save as option of the File menu. Enter a non-existing name for the current project file and click the Save button.
• Select the geometry line on which the prescribed displacement was applied and press the <Del> key on the keyboard. Select \textit{Prescribed displacement} from the \textit{Select items to delete} window and click the \textit{Delete} button.

Click the \textit{Plate} button in the toolbar.

• Move to position (0.0; 4.0) and press the left mouse button.

• Move to position (0.9; 4.0) and press the left mouse button, followed by the right mouse button to finish drawing. A plate from point 3 to point 4 is created which simulates the flexible footing.

\textbf{Modifying the load conditions}

Click the \textit{Standard fixities} button. Within the standard fixities option, a rotation fixity will be added to any plate that reaches a boundary node where at least one displacement degree-of-freedom is prescribed. In this case a rotation fixity will be added to point (0.0; 4.0).

Click the \textit{Distributed loads - load system A} button in the toolbar.

• Click point (0.0; 4.0) and then on point (0.9; 4.0).

• Press the right mouse button to finish the input of the tractions. Use the default input value of the traction load (1.0 kN/m$^2$ perpendicular to the boundary).

\textbf{Adding material properties for the footing}

Click the \textit{Material sets} button.

• Select \textit{Plates} from the \textit{Set type} combo box in the \textit{Material Sets} window.

• Select the existing material data set and click \textit{Edit}. A new window appears in which the properties of the footing can be entered.

• Write “Footing” in the \textit{Identification} box and select the \textit{Elastic} material type.

• Enter the properties as listed in Table 3.2.

• Click the \textit{OK} button. The modified data set now appears in the tree view of the \textit{Material Sets} window.

• Drag the set “Footing” to the draw area and drop it on the footing. Note that the cursor changes shape to indicate when it is valid to drop the material set. The plate should briefly blink red and change colour from light blue to dark blue, indicating a material set has been assigned.

• Close the database by clicking on the \textit{OK} button.
Table 3.2 Material properties of the footing

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axial stiffness</td>
<td>$EA$</td>
<td>$5.0 \times 10^6$</td>
<td>kN/m</td>
</tr>
<tr>
<td>Flexural rigidity</td>
<td>$EI$</td>
<td>$8.5 \times 10^3$</td>
<td>kNm²/m</td>
</tr>
<tr>
<td>Equivalent thickness</td>
<td>$d$</td>
<td>0.143</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>$w$</td>
<td>0.0</td>
<td>kN/m/m</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$v$</td>
<td>0.0</td>
<td>-</td>
</tr>
</tbody>
</table>

**Hint:** If the Material Sets window is displayed over the footing and hides it, move the window to another position so that the footing is clearly visible.

**Generating the 2D mesh**

Click the Mesh generation button to generate the 2D finite element mesh. A warning appears, indicating that by regenerating the mesh, the staged construction definitions become invalid and will be cleared. Press the OK button.

- After viewing the mesh, click the Update button.

**3D Mesh Generation**

Click the Generate 3D mesh button in the toolbar, or select the Generate 3D mesh option from the Mesh menu. Accept the existing positions of the cross-section planes (-5.00, -0.90, 0.00) and click the Generate button.

- After viewing the 3D mesh click the Update button to return to the geometry input mode.

**Initial conditions**

Back in the Geometry input mode, click the Initial conditions button.

Since the current project does not involve pore pressures, proceed to the Geometry configuration mode by clicking on the 'switch' in the toolbar.

- In the Geometry configuration you can see that the footing and the external load are deactivated.
Click the Generate initial stresses button, after which the $K_0$-procedure dialog box appears.

- Keep $\Sigma M_{\text{weight}}$ equal to 1.0 and accept the default value of $K_0$ for the single cluster.
- Click the OK button to generate the initial stresses.
- After viewing the initial stresses, click the Update button.
- Click the Calculate button and confirm the saving of the current project.

**Calculations**

- Redefine the first calculation phase by proceeding to the Parameters tab sheet and clicking on the Define button in the Loading input box (Loading input = staged construction).
- In the Staged Construction window activate the Plate and the Distributed Load System A in Slice 1 by clicking on the corresponding geometry line. A menu Select items will appear in which Plate and Distributed Load System A have to be selected. While Distributed Load System A is highlighted, click the Change button to change the input load from the default value (-1.0) to the value of -370 kN/m² that is to be applied here. (Note that this applied pressure corresponds closely to the total load of 1200 kN that was calculated using the model described in the first part of this lesson.)
- Click the preview button to verify the settings made in Staged construction. Press Update to return to Staged construction and another Update to return to calculations.

Check the nodes and stress points for load-displacement curves to see if the required points are still selected (the mesh has been regenerated so the nodes might have changed!).

- Make sure that only the first calculation phase is set to be calculated (blue arrow before phase). Double clicking a calculation phase activates or deactivates it.
- Click the Calculate button to start the calculation.

**Viewing the results**

- After the calculation the results of the final calculation step can be viewed by clicking on the Output button while the first phase is selected. View the plots that are of interest. The displacements and stresses should be comparable to those obtained from the first part of the exercise.
- Select the tab front plane and double-click the footing. A new window opens in which either the displacements or the bending moments of the footing may be plotted (depending on the type of plot in the first window).
• Note that the menu has changed. Select the various options from the Forces menu to view the forces in the footing.

**Hint:** Multiple sub-windows may be opened at the same time in the Output program. All windows appear in the list of the Window menu. PLAXIS conforms to the Windows standard for the presentation of sub-windows (Cascade, Tile, Minimize, Maximize, etc). See your Windows manual for a description of these standard display options.

**Generating a load-displacement curve**

In addition to the results of the final calculation step it is often useful to view a load-displacement curve. For this purpose the fourth program in the 3D Tunnel package is used. To generate the load-displacement curve as shown in Figure 3.20, follow these steps:

- Click the Go to curves program button on the toolbar. As a result, the Curves program will start up.
- Select New chart from the Create / Open curve dialog box.
- Make sure that the Files of type combo box is set to Plaxis 3D Tunnel project files. Select the file name of the latest footing project and click the Open button.

A Curve generation window now appears (Figure 3.19), consisting of two columns (x-axis and y-axis), with multiple radio buttons and two combo boxes for each column. The combination of selections for each axis determines which quantity is plotted along the axis.

![Figure 3.19 Curve generation window](image)
• For the X-axis select the Displacement radio button, from the Point combo box select A (0.00 / 4.00 / 0.00), from the Type combo box select $U_y$. Also select the Invert sign option. Hence, the quantity to be plotted on the x-axis is the vertical displacement of point A (i.e. the centre of the footing).

• For the Y-axis, select the Multiplier radio button and from the Type combo box select $\Sigma M_{\text{Stage}}$. Hence, the quantity to be plotted on the y-axis is the multiplier for the applied load. $\Sigma M_{\text{stage}} = 1.0$ corresponds to an external distributed load of 370 kN/m².

• Click the OK button to accept the input and generate the load-displacement curve. As a result, the curve shown in Figure 3.20 is plotted in the Curves window.

Hint: To re-enter the Curve generation window (in case of a mistake, a desired regeneration or modification) you can click the Change curve settings button from the toolbar. As a result the Curve settings window appears, on which you should click the Regenerate button in the Miscellaneous box. Alternatively, you may open the Curve settings window by selecting the Curve option from the Format menu.

> The Curve settings window may also be used to modify the attributes or presentation of a curve.

> The Frame settings window may be used to modify the settings of the frame. This window can be opened by clicking on the Change frame settings button from the toolbar or by selecting the Frame option from the Format menu.

Figure 3.20 Load-displacement curve for the footing
In this lesson the staged excavation and construction of a NATM tunnel will be considered (NATM = New Austrian Tunneling Method). NATM is characterised by the fact that a tunnel is excavated in different parts (for example, crown, bench and invert), where subsequent parts are executed at a certain distance (lag) behind the previous part. After each excavation part the tunnel contour is secured by means of a temporary lining of sprayed concrete. A final lining can be installed later if the long term soil conditions require such. NATM can be applied in rock, soft rock, hard soils or overconsolidated clays.

In this example we consider a NATM tunnel in sandstone, as indicated in Figure 4.1. The real tunnel excavation is divided into three parts, i.e. the crown, the bench and the invert. However, the modelling is restricted here to the crown and the bench only to reduce the model size, but this includes the most critical construction stages.

It is the purpose of this 3D analysis to demonstrate the set-up of a model for NATM tunnelling projects and to define the respective calculation phases. The model is basic and coarse in order to restrict the computation time and memory consumption. The calculation itself will last about half an hour, but it is interesting to perform and to evaluate the results.

![Figure 4.1 Geometry of NATM tunnel, cross section view (left) and side view (right)](image)

### 4.1 GEOMETRY

The sandstone is considered to be homogeneous. The top of the tunnel is 10.75 m below the surface of the sandstone. The full tunnel has a height of 9.25 m and a width of 10 m. However, only the crown and bench are included in the model. The crown is excavated in a section of 1.0 m length. After the excavation the surrounding sandstone is secured
with sprayed concrete. As in the Introductory Version the amount of planes is limited, only one excavation step is modelled.

The ordering of excavation phases is indicated in Figure 4.1. The excavation of the bench is always some meters behind the heading. A length of 8 m behind the bench excavation is included in the model to create the starting situation. The invert is much further behind and is not included in the model. For reasons of symmetry and to save computer time, only one half of the geometry is modelled, whereas symmetry conditions are adopted at the centre plane. The model is extended 29 m sideways from the centre plane and 10 m in front of the tunnel heading to avoid any influence from the boundaries. At the intersection of the bench and the invert, the lining is thickened to provide sufficient support for the crown arch. This thickening is modelled by means of a small side plate. To create the cross-section model and finite element mesh, follow these steps:

**General settings**

- Start the Input program and select *New project* from the *Create / Open project* dialog box.
- In the *Project* tab sheet of the *General settings* window, enter an appropriate title and make sure that *Declination* is set to 0° in the *Model orientation* box.
- In the *Dimensions* tab sheet, keep the default units (Length = m; Force = kN; Time = day) and enter for the horizontal dimensions (Left, Right) 0.0 and 25.0 respectively and for the vertical dimensions (Bottom, Top) 0.0 and 20.0. In the *Grid* box enter *Spacing* = 1m and *Number of intervals* = 2).
- Click the *OK* button, after which the draw area appears.

**Geometry contour, layers and structures**

The geometry contour: Select the *Geometry line* button from the toolbar (this should, in fact, already be selected for a new project). Move the cursor to the origin (0.0; 0.0) and click the left mouse button. Move 25 m to the right (25.0; 0.0) and click again. Move 20 m up (25.0; 20.0) and click again. Move 25 m to the left (0.0; 20.0) and click again. Finally, move back to the origin and click again. A cluster is now detected. Click the right mouse button to stop drawing.

The NATM tunnel: Click the *Tunnel* button and the *Tunnel designer* will appear. Select the *Left half tunnel* button to create the left half of the tunnel.

- Select as *Type of tunnel: NATM tunnel*. The *Thickness* must remain zero. The thickness option is only used to create a double tunnel contour, for example to create a massive tunnel lining composed of volume elements. In this case, however, the tunnel lining will be composed of shell elements.

Make sure that the tunnel has a *Shell* (shown as a heavy blue line) but no *Interface* (shown as a dotted line). The interface can be removed from the tunnel by clicking on the *Remove all interfaces* button. No interface is needed.
because the interaction between the lining and the surrounding sandstone is rather strong.

A tunnel is composed of different sections. A section may be an Arc, a Line or a Corner. Corners are used to introduce a sharp transition angle from one section to another.

In this example the invert is not modelled and the 'bottom' of the tunnel is formed by a straight line, after which a corner is introduced to continue with the bench and crown contour (Figure 4.2).

Figure 4.2 Tunnel designer with left half of NATM tunnel

- Section 1: Select for Type: Line. Enter a Length of 5.0 m. For the y-coordinate of the Centre of the tunnel, enter a value of -2 m, to adapt the origin of the local tunnel axes. This will enhance the positioning of the tunnel in the geometry model (see below). Click the <►> button to proceed to the next tunnel section.
- Section 2: Select for Type: Corner. Enter an Angle of 90°. Proceed to the next section.
- Section 3: Select for Type: Arc. Enter a Radius of 7.5 m and an Angle of 37°.
- Section 4: Select for Type: Arc. Keep the default values for the Radius (4.37 m) and Angle (53°). These values were automatically determined to complete the tunnel half. An overview of all tunnel sections is given in Table 4.1.
- Close the Tunnel designer by pressing OK.
• The cursor is shaped as a tunnel to indicate that the tunnel is about to be placed in the geometry. The position of the pointer corresponds with the origin of the local tunnel axes. Move the cursor to (25.0, 5.0) and click once. The tunnel is now integrated in the geometry.

Table 4.1 Geometrical properties per section for the left half of the NATM tunnel

<table>
<thead>
<tr>
<th>Section</th>
<th>Type of section</th>
<th>Length / Radius (m)</th>
<th>Angle (°)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Line</td>
<td>5.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Corner</td>
<td></td>
<td>90.0</td>
</tr>
<tr>
<td>3</td>
<td>Arc</td>
<td>7.50</td>
<td>37.0</td>
</tr>
<tr>
<td>4</td>
<td>Arc</td>
<td>4.37</td>
<td>53.0</td>
</tr>
</tbody>
</table>

Hint: The point where the tunnel is inserted in the cross section model is called the *Tunnel reference point*. An existing tunnel may be edited by double-clicking the tunnel reference point. As a result, the tunnel designer appears in which the existing tunnel is presented.

> It may be useful to zoom into the tunnel area to create geometry details as the separation line and the side plate.

> Within the geometry input mode it is not strictly necessary to select the buttons in the toolbar in the order that they appear from left to right.

> When creating a point very close to a line, the point is usually snapped onto the line, because the mesh generator cannot handle non-coincident points and lines of a very short length. This procedure also simplifies the input of points that are intended to lie exactly on an existing line.

> If the pointer is substantially mis-positioned and instead of snapping onto an existing point or line a new isolated point is created, this point may be dragged (and snapped) onto the existing point or line by using the Selection button and the mouse.

> In general, only one point can exist at a certain coordinate and only one line can exist between two points. Coinciding points or lines will automatically be reduced to single points or lines. The procedure to drag points onto existing points may be used to eliminate redundant points on a line. Alternatively, the <Del> key may be used.

The tunnel contour will now be completed with the separation line between the crown and the bench and finally with a thickening of the lining.

• Select again the *Geometry line* button. Move the cursor to position (21.5; 7.5). There is an existing geometry point that corresponds approximately with this position. Click on this point.

• Move to position (23.0; 6.0) and click again.

• Move to position (25.0; 6.0) and click again.
Click the *Plate* button. Move the cursor to position (20.0; 3.0), i.e. the corner point of the tunnel, and click on this point. Move 0.5 m to the left (19.5; 3.0) and click again. Do not stop the drawing process.

- The final point of the side plate support lies on the tunnel lining and requires some accuracy; therefore enter the coordinates of this final point on the keyboard (20.27; 5.0). This is done by typing 20.27 <Space> 5 <Enter>.

**Boundary Conditions**

To create the boundary conditions, click the *Standard fixities* button on the toolbar. As a result, the program will generate full fixities at the bottom, vertical rollers at the vertical sides and rotation fixities at the ends of the tunnel lining in the symmetry plane. Rotation fixities will prevent the tunnel lining centre from rotating. These boundary conditions are appropriate to model the conditions of symmetry at the right hand boundary (centre line of the real tunnel). The geometry model is shown in Figure 4.3.

![Figure 4.3 Geometry model of the NATM tunnel (excluding invert)](image)

**Material properties**

One material set is adopted for the sandstone. For the sprayed concrete a single plate material set is created. The properties are given in Table 4.2 and Table 4.3. To define the properties, follow these steps:

- Click the *Material sets* button on the toolbar. Select *Soil & interfaces* as the *Set type*.
- Select the material data set and click the *Edit* button.
• For the sandstone layer, enter “Sandstone” for the Identification and select Mohr-Coulomb as the Material model. The material type is set to Drained.

• The permeability of the soil is only important if groundwater is present. In this case, it is assumed there is no groundwater so the permeability can be left to the default values.

• Enter the properties of the sandstone layer, as listed Table 4.2, in the corresponding edit boxes of the General and Parameters tab sheet. To enter the Tensile Strength of 5 kN/m², click the Advanced button in the Parameters tab sheet. Make sure that the Tension cut off option remains checked.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Sandstone</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Soil weight above phr. level</td>
<td>γ&lt;sub&gt;unsat&lt;/sub&gt;</td>
<td>20.0</td>
<td>kN/m&lt;sup&gt;3&lt;/sup&gt;</td>
</tr>
<tr>
<td>Soil weight below phr. level</td>
<td>γ&lt;sub&gt;sat&lt;/sub&gt;</td>
<td>20.0</td>
<td>kN/m&lt;sup&gt;3&lt;/sup&gt;</td>
</tr>
<tr>
<td>Young's modulus (constant)</td>
<td>E&lt;sub&gt;ref&lt;/sub&gt;</td>
<td>2.0.10&lt;sup&gt;5&lt;/sup&gt;</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>ν</td>
<td>0.25</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion (constant)</td>
<td>c&lt;sub&gt;ref&lt;/sub&gt;</td>
<td>25.0</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Friction angle</td>
<td>φ</td>
<td>35.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>ψ</td>
<td>5.0</td>
<td>°</td>
</tr>
<tr>
<td>Tensile strength (tension cut-off)</td>
<td>TS</td>
<td>5.0</td>
<td>kN/m²</td>
</tr>
</tbody>
</table>

• The interface properties are not relevant in this example. Click the OK button to close the data set.

• Drag and drop the Sandstone data set to all soil clusters in the geometry model, including the small cluster inside the thickening tunnel lining (Figure 4.3).

• Set the Set type parameter in the Material sets window to Plates, select the material set and click the Edit button. Enter “Sprayed concrete lining” as an Identification of the data set and enter the properties as given in Table 4.3.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of behaviour</td>
<td>Material type</td>
<td>Elastic</td>
<td>kN/m</td>
</tr>
<tr>
<td>Normal stiffness</td>
<td>EA</td>
<td>3.00.10&lt;sup&gt;6&lt;/sup&gt;</td>
<td>kNm&lt;sup&gt;2&lt;/sup&gt;/m</td>
</tr>
<tr>
<td>Flexural rigidity</td>
<td>EI</td>
<td>2.25.10&lt;sup&gt;4&lt;/sup&gt;</td>
<td>m</td>
</tr>
<tr>
<td>Equivalent thickness</td>
<td>d</td>
<td>0.3</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>w</td>
<td>8.4</td>
<td>kN/m/m</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>ν</td>
<td>0.15</td>
<td>-</td>
</tr>
</tbody>
</table>
Click the OK button to close the data set.

Drag and drop the Sprayed concrete lining data set to all individual tunnel plates in the geometry (including the floor and side plate). This can be checked as the plate will change colour from light blue to dark blue when a data set has been assigned. Close the data base.

2D Mesh Generation

To generate an appropriate finite element mesh, follow these steps:

Click the Generate mesh button in the toolbar. A few seconds later, a very coarse mesh is presented in the Output window. When a tunnel is included in the cross section model, the 3D Tunnel program automatically refines the mesh at the tunnel contour, which can be seen from the output plot. However, the mesh is still too coarse for this exercise. Click the Update button to return to the geometry input.

Back in the Input program, select the two clusters inside the tunnel contour simultaneously (hold down the <Shift> key while selecting). From the Mesh menu, select the Refine cluster option. After the new mesh has been generated and updated, select Refine Global from the Mesh menu.

![Figure 4.4 2D finite element mesh of NATM tunnel project](image)

**Hint:** The mesh settings are stored together with the rest of the input. On re-entering an existing project and not changing the geometry configuration and mesh settings, the same mesh can be regenerated by just clicking on the Generate mesh button on the toolbar. However, any slight change of the geometry will result in a different mesh.
Hint: The Reset all option from the Mesh menu may be used to restore the default setting for the mesh generation (Global coarseness = Very coarse and no local refinement, except at the tunnel contour).

3D Mesh Generation

For the 3D mesh generation, i.e. the positioning of z-planes, it is important to consider the staged excavation process, as shown in Figure 4.1. In addition to the front of the model, subsequent slices with respective thicknesses of 8.0 m, 9.0 m, 1.0 m and 11.0 m are required. The total length of the model is 29 m. Considering the Front plane of the model at 0.0 m, four new z-planes are inserted with coordinates as listed in Figure 4.5.

![3D mesh generation](image)

Figure 4.5 3D mesh generation. Coordinates of z-planes

To generate the 3D mesh, follow these steps:

- Click the Generate 3D mesh button in the toolbar or select the Generate 3D mesh option from the Mesh menu.
- Press 4 times Insert and change the z-coordinates of the planes according to Figure 4.5.
- Click the Generate button. The 3D mesh extension procedure is started and the 3D mesh is displayed in the Output window (Figure 4.6).
- Click the Update button to return to the geometry input mode.
Initial conditions

The initial conditions of the current project do not require the generation of water pressures, only initial stresses have to be generated.

To generate the appropriate initial conditions, follow these steps:

1. Click the Initial conditions button on the toolbar.
   - Click OK to accept the default value of the unit weight of water, which is 10 kN/m³. The Water conditions mode then becomes active.
2. As no groundwater is present, proceed to the Geometry configuration mode by clicking on the 'switch' in the toolbar.
   - Click the Generate initial stresses button in the toolbar. The $K_0$-procedure dialog box appears.
3. Keep the total multiplier for soil weight equal to 1.0. Select the check box $K_{0,z}$ is equal to $K_{0,x}$ and enter $K_0$-values of 0.5 for all clusters. Click the OK button.
4. After the generation of the initial effective stresses, the result is displayed in the Output window. Click the Update button to return to the Geometry configuration mode.
5. Click the Calculate button. Select Yes in response to the question about saving the data and enter an appropriate file name.

4.2 CALCULATIONS

In the calculations the four excavation parts will be considered as indicated in Figure 4.1. In fact, the phased tunnel construction is a continuing process. Therefore, a starting
situation is created first. Each of the four excavation parts is divided into two phases, namely the excavation before the temporary lining is installed and the installation of the temporary sprayed concrete lining itself.

In PLAXIS, these processes can be simulated by means of the Staged construction calculation option. Staged construction enables the activation or deactivation of weight, loads, stiffness and strength of selected components of the finite element model. The current lesson explains the use of this powerful calculation option for the simulation of NATM tunnel construction.

**Hint:** The Staged construction option is not only intended to simulate excavations or constructions, but it can also be used to change the water pressure distribution, to apply loads, z-loads, prescribed displacements, volume strains, to change material properties (to simulate soil improvement, for example) or to improve the accuracy of previous computational results.

*Staged construction* is only available within 3D Plastic calculations. To define all calculation phases, follow the steps outlined below:

### Phase 1

- Select the first calculation phase (i.e. the starting situation *Phase 1*). In the General tab sheet, accept all defaults (*Calculation type* = 3D Plastic analysis, *Start from phase* = 0 - Initial phase).
- In the Parameters tab sheet, keep the default values for the Control parameters and the Iterative procedure. Staged construction is already pre-selected from the Loading input box.
- Click the Define button. The Staged construction window appears, showing the Front plane and the currently active part of the geometry, which is the full geometry except for the tunnel lining. Switch to Slice 1 by clicking on the tab named Slice 1.
- Click the two clusters inside the tunnel to deactivate them.
- Click on each section of the tunnel lining, except the bottom, to activate the tunnel lining in Slice 1. Make sure that the side plates are also activated (use the zoom option to zoom into this area).
- Select the Slice 2 tab. Click the crown cluster to deactivate this part. Click the upper part of the tunnel lining to activate this part.

Press the Preview button to check whether the situation is properly defined (see Figure 4.7). After verification, press the Update button to return to the Geometry configuration mode and another Update to return to the Calculations window.
Hint: When activating geometry objects, their stiffness and strength becomes active from the beginning of the calculation, whereas their weight is increased gradually. This is why the first excavation can be defined together with the activation of the tunnel lining.

Phase 2
- In the Calculations window, select Phase 2.
- In the General tab sheet, accept all defaults (Calculation type = 3D Plastic analysis, Start from phase = 1 – <Phase 1>).
- In the Parameters tab sheet, keep the default values for the Control parameters and the Iterative procedure and verify that Staged construction is selected from the Loading input box. Click the Define button.
- In the Staged construction window, select Slice 3 and de-activate the crown of the tunnel. The corresponding lining part must remain inactive.
- Click Update to return to the Calculations window.

Phase 3
- Select the next calculation phase. Accept all defaults in the General tab sheet and the Parameters tab sheet. In the Loading input box (Staged construction), click the Define button.
- In the Staged construction window, select Slice 3 and activate the lining along the crown of the tunnel. Click Update.
Check if only the first three calculation phases are active (blue arrow). Double clicking a phase activates or deactivates it.

Figure 4.8  Final calculation stage of NATM tunnel project (Phase 3)

The calculation definition is now complete. Before starting the calculation it is suggested to select nodes or stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this, follow the steps given below.

- Press on the Select points for curves button in the toolbar.
- Select the upper right-hand node in the Front plane.
- Click the Stress points button. As a result, the plot displays the stress points, which are different from the nodes.
- Click the Plane A tab. Select a stress point just above the tunnel and one just left of the bench. Choose the light coloured stress points.
- Click the Update button to return to the Calculations window.
- Select Phase 1 and start the calculation by pressing the Calculate button.

**Hint:** In contrast to nodes, stress points do not coincide with $z$-planes. When selecting a plane the closest stress points around the plane are shown. Stress points with a higher $z$-coordinate than the selected plane are given a light colour, whereas stress points with a lower $z$-coordinate are given a dark colour.

The calculation process should now start. The program searches for the first calculation phase that is selected for execution, which in this case is Phase 1.
During a Staged construction calculation, a multiplier called $\Sigma M_{\text{stage}}$ is increased from 0.0 to 1.0. This parameter is displayed on the calculation information window. As soon as $\Sigma M_{\text{stage}}$ has reached the value 1.0, the construction stage is completed and the calculation phase is finished. If a Staged construction calculation finishes while $\Sigma M_{\text{stage}}$ is smaller than 1.0, the program will give a warning message. The most likely reason for not finishing a construction stage is that a failure mechanism has occurred, but there can be other causes as well. See the Reference Manual for more information about Staged construction.

In this example, all calculation phases should successfully finish, which is indicated by the green tick mark in the list. To check the values of the $\Sigma M_{\text{stage}}$ multiplier, click the Multipliers tab and select the Reached values radio button. The $\Sigma M_{\text{stage}}$ parameter is displayed at the bottom of the Other box that pops up. Verify that this value is equal to 1.0 for all phases.

### 4.3 VIEWING OUTPUT RESULTS

After the calculations, the results of each individual phase can be viewed by selecting the appropriate phase in the Calculations window and pressing the Output button. When multiple phases are selected simultaneously (hold down the <Ctrl> or <Shift> while selecting phases) and the Output button is pressed, all these phases are stored in separate windows of the output program. In this case, results from different phases can easily be compared.

- Select the third calculation phase and click the Output button. The Output window shows the deformed mesh of the final phase. Evaluate the results in terms of surface settlements, inward movement of the crown top, heave of the bench bottom, etc. The heave of the bench bottom may be unrealistically large since the Mohr-Coulomb model does not distinguish between loading and unloading stiffness.

- From the Deformations menu, select Total displacements. Select Arrows from the presentation combo box.

- Select the Plane A tab sheet.

Click the Cross section button in the toolbar and draw a horizontal cross section at a level of $y = 7.0$ m. Use the <Shift> key while drawing in order to create a perfectly horizontal line. The coordinates of the cursor can are displayed at the bottom of the window when a plane is selected. Now select Deformations plane from the presentation combo box. The plot clearly shows the effect of the altered stress state around the tunnel, including uplift of the base of the bench due to unloading. Using the arrow keys, the image can be rotated and the deformations along the tunnel axis can be seen (Figure 4.9).

- Now select Principal stresses from the Stresses menu. The plot clearly shows the effect of horizontal arching.
It is interesting to view the developments of stresses for different points around the tunnel. This can be done in the Curves program by plotting the stress paths for the two selected stress points. To do this, follow the steps given below:

- Start the Curves program and create a new chart.
- Select the NATM tunnel project and press the Open button.
- In the Curve generation window, select for the x-axis the stress option, choose the stress point above the tunnel, set Type to sig' -xx and select the Invert sign option. For the y-axis, select the stress option, choose the same point, set Type to sig' -yy and select the Invert sign option. Press OK to close the window.

   Click the Add curve button and select From current project. In the Curve generation window, select the same as above but choose the other stress point.

   **Hint:** Usually, stress-stress curves are presented with orthonormal axes. To change this setting, open the Chart item from the Format menu. In the Chart settings window, uncheck the Orthonormal axes option and click OK.
From Figure 4.10 it can be seen that in point B (above the tunnel) the vertical stress decreases due to the excavation of the tunnel, whilst the horizontal stress remains more or less equal. The stress develops from a $K_0$-stress state towards a passive stress state. In point C (besides the tunnel) the horizontal stress decreases due to the excavation of the tunnel, whilst the vertical stress remains more or less equal. The stress develops from a $K_0$-stress state towards an active stress state.

Figure 4.10 Stress components $\sigma'_xx$ and $\sigma'_yy$ in points above the crown (B) and near the bench (C)
5 TUNNEL HEADING STABILITY (LESSON 3)

This lesson illustrates the use of the PLAXIS 3D Tunnel program for a shield tunnel heading stability calculation. Many of the program features that were used in Lesson 1 and 2 will be utilised here again. In addition, some new features will be used, such as interfaces, z-loads, the generation of water pressures and the calculation of a safety factor. The new features will be described fully, whereas the features that were treated in previous lessons will be described in less detail. Therefore it is suggested that the previous lessons should be completed before attempting this exercise.

This example concerns the stability of the heading of a bored tunnel. While excavating the tunnel, the tunnel heading needs support in the form of liquid, air, ground pressure or mechanical pressure. This pressure must be bounded between a minimum and maximum depending on the soil properties, the depth of the tunnel and the groundwater pressure at the face of the tunnel heading. The minimum face pressure is determined mainly by the need to compensate for the groundwater pressure. A too low pressure can lead to inward collapse of the tunnel heading (active failure). A too high pressure can result in a blow out of the heading (passive failure); at the same time, large deformations may occur at the ground surface.

In this lesson we will search for the minimum face pressure that is required to keep the tunnel heading stable by lowering the applied face pressure until collapse occurs. We will also determine a global safety factor with the original pressure applied.

![Figure 5.1 Geometric model of tunnel excavation](image-url)
5.1 GEOMETRY

The tunnel excavation is carried out by a tunnel boring machine (TBM) which is 8.6 m long and 8.5 m in diameter. The axis of the tunnel lies 7.0 m below mean sea level (MSL), which is 9.0 m below the ground surface. The present groundwater head corresponds to the MSL. In the model, only one symmetric half is included. The model is 20.0 m wide, it extends 25.0 m in the z-direction and it is 20.0 m deep. With these dimensions, the model is sufficiently large to allow for any possible collapse mechanism to develop and to avoid any influence from the model boundaries.

The subsoil consists of three layers. The soft upper sand layer is 2.0 m deep and extends from the ground surface to MSL. Below the upper sand layer there is a clay layer of 12.0 m thickness and this layer is underlain by a stiff sand layer that extends to a large depth. Only 6.0 m of the stiff sand layer is included in the model. Hence, the bottom of the model is 18.0 m below MSL. As only one data set for soil can be generated in the Introductory Version, all soil layers are modelled using one set of properties.

The tunnel excavation process is simulated in one excavation stage. The interaction between the TBM and the soil is modelled by means of an interface. The interface allows for the specification of a reduced friction compared to the strength of the soil. The tunnel face pressure is modelled by means of a z-load, which is applied in the excavation stage. For background information on these new procedures, see the Reference Manual.

![Figure 5.2 Geometry model in the Input window](image)

To create the geometry model, follow these steps:
General settings

- Start the Input program and select *New project* from the *Create / Open project* dialog box.
- In the *Project* tab sheet of the *General settings* window, enter an appropriate title and make sure that *Declination* is set to 0° in the *Model orientation* box.
- In the *Dimensions* tab sheet, keep the default units (*Length* = m; *Force* = kN; *Time* = day) and enter the horizontal dimensions (*Left, Right*) 0.0 and 20.0 respectively and for the vertical dimensions (*Bottom, Top*) -18.0 and +2.0. Keep the default values for the grid spacing (*Spacing* = 1 m; *Number of intervals* = 1).
- Click the *OK* button after which the draw area should appear.

Geometry contour, layers and structures

The geometry contour. Select the *Geometry line* button from the toolbar (this should, in fact, already be selected for a new project). Move the cursor to the position (0.0; -18.0) and click the left mouse button. Move 20 m to the right (20.0; -18.0) and click again. Move 20 m up (20.0; 2.0) and click again. Move 20 m to the left (0.0; 2.0) and click again. Finally, move back to the first point (0.0; -18.0) and click again. A cluster is now automatically generated. Click the right mouse button to stop drawing.

The shield tunnel. Click the *Tunnel designer* button and the *Tunnel designer* will pop up. Select the *Left half tunnel* button to create the left half of the tunnel.

- Accept the default setting for the tunnel type: *Bored tunnel*. Keep the *Thickness* equal to zero.
- A bored tunnel is circular by definition, therefore only one radius can be entered. This is done in *Section 1*. Enter 4.25 m for the *Radius* parameter. Keep the default value for the *Angle* parameter (60°). Proceed to *Section 2*. The *Radius* is automatically updated to 4.25 m. The *Angle* must remain at 60°. Verify that *Section 3* is similar.
- Make sure a *shell* (representing the TBM) and *interface* are present at the tunnel contour.

**Hint:** Interfaces are indicated as dotted lines along a geometry line. To identify interfaces at either side of a geometry line, a positive sign (⊕) or negative sign (⊖) is added.

> The selection of an interface is done by selecting the corresponding geometry line and subsequently selecting the corresponding interface (positive or negative) from the *Select* dialog box.

> Since tunnels will only interact with the surrounding soil at the outside of the tunnel, only an outside interface is added to the tunnel geometry.
• Click OK to close the tunnel designer.

• Move the cursor, which appears as a tunnel, to (20.0, -9.0) and click once to introduce the tunnel in the cross section model.

**Boundary Conditions**

To create the boundary conditions, click the *Standard fixities* button on the toolbar. As a result, the program will generate full fixities at the bottom, vertical rollers at the vertical sides and rotation fixities to the tunnel liner on its plane of symmetry. The geometry model is shown in Figure 5.2.

**Material properties**

After the input of boundary conditions, the material properties of the soil clusters and other geometry objects are entered in data sets. Interface properties are included in the data sets for soil (Data sets for *Soil & interfaces*). To create the material data set, follow these steps:

1. Click the *Material sets* button on the toolbar. Select *Soil & interfaces* as the *Set type*. Select the existing data set and click *Edit*.
2. Enter “Soil” for the *Identification* and select *Mohr-Coulomb* as the *Material model*. The material type is set to *Drained*.
3. Enter the properties of the soil layer, as listed Table 5.1, in the corresponding edit boxes of the *General* and *Parameters* tab sheet.
4. Click the *Interfaces* tab. In the *Strength* box, select the *Manual* radio button. Enter a value of 0.85 for the $R_{inter}$ parameter. Close the data set.
5. Drag the “Soil” data set to the clusters of the geometry and drop it there.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Soil</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Soil weight above phr. level</td>
<td>$\gamma_{\text{unsat}}$</td>
<td>16.5</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Soil weight below phr. level</td>
<td>$\gamma_{\text{sat}}$</td>
<td>19.0</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Young's modulus (constant)</td>
<td>$E_{\text{ref}}$</td>
<td>$4\cdot10^4$</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$\nu$</td>
<td>0.3</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion (constant)</td>
<td>$c_{\text{ref}}$</td>
<td>3.0</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\phi$</td>
<td>28.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0.0</td>
<td>°</td>
</tr>
<tr>
<td>Interface strength reduction</td>
<td>$R_{\text{inter}}$</td>
<td>0.85</td>
<td>-</td>
</tr>
<tr>
<td>Coefficient of lateral earth pressure</td>
<td>$K_0$</td>
<td>0.5</td>
<td>-</td>
</tr>
</tbody>
</table>
To model the interaction between the soil and the tunnel lining, an interface (shown as a dotted line) was created around the tunnel lining. The interface is modelled in the mesh by interface elements (see page 3.3.4 of the Reference Manual).

The interface properties are defined by the parameter $R_{inter}$ that can be set in the Interfaces tab sheet of a soil material set. When the Interfaces tab sheet is skipped, the $R_{inter}$ parameter will have a default value of 1.0 (rigid). The $R_{inter}$ parameter relates the strength of the interfaces to the strength of the soil, according to the equations:

$$\tan \varphi_{interface} = R_{inter} \tan \varphi_{soil} \quad \text{and} \quad c_{inter} = R_{inter} c_{soil}$$

With the default value $R_{inter} = 1.0$ (rigid), $c_{inter} = c_{soil}$ and $\varphi_{inter} = \varphi_{soil}$.

In general, strength properties in the interaction zone between soil and structures are lower than the adjacent soil. This reduction can be specified using the $R_{inter}$ parameter. Hence, using $R_{inter} < 1.0$ gives a reduced interface friction and adhesion compared to the friction angle and the cohesion in the adjacent soil. The 2D cross section will be extended in the $z$-direction to create the 3D model. As the interface is present in the 2D cross section, it will also be present in all slices of the 3D model.

In addition to the material data set for soil, a data set of the plate type is created for the TBM.

- Set the Set type parameter in the Material sets window to Plates. Select the existing data set and click the Edit button.
- Enter “TBM” as an Identification of the data set and enter the properties as given in Table 5.2. Click the OK button to close the data set.

### Table 5.2 Material properties of the TBM

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of behaviour</td>
<td>Material type</td>
<td>Elastic</td>
<td>kN/m</td>
</tr>
<tr>
<td>Axial stiffness</td>
<td>$EA$</td>
<td>8.20·10^6</td>
<td>kNm/m</td>
</tr>
<tr>
<td>Flexural rigidity</td>
<td>$EI$</td>
<td>8.38·10^4</td>
<td>kNm²/m</td>
</tr>
<tr>
<td>Equivalent thickness</td>
<td>$d$</td>
<td>0.35</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>$w$</td>
<td>38.15</td>
<td>kN/m/m</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$\nu$</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

- Drag the “TBM” data set to the tunnel shell in the geometry and drop it as soon as the cursor indicates that dropping is possible. For a bored tunnel, the tunnel shell is considered to be one continuous and homogeneous object in the cross-section model.
- Close the material sets window by pressing the OK button.
**2D Mesh Generation**

In this lesson a coarse mesh is used. To generate the proposed mesh, follow these steps:

- Click the *Generate mesh* button in the toolbar. A few seconds later, a very coarse mesh is shown in the Output window. The 3D Tunnel program automatically refines the mesh at the tunnel points. Although the interface has a zero thickness, it is given an arbitrary thickness in the plot to visualise the connectivity’s between the various elements. Click the *Update* button to return to the geometry input.

- Select *Refine global* from the *Mesh* menu to refine the entire mesh. This will result in a coarse mesh. Click *Update* to return to the geometry input.

![Figure 5.3 2D finite element mesh of the shield tunnel project](image)

**3D Mesh Generation**

Only the TBM (which is 8.6 m long) and 16.4 m of soil ahead of the TBM are modelled. Hence, the 3D model extends 25.0 m in the z-direction. Three planes are required to model the situation: a front plane at 0.0 m, an intermediate plane at –8.6 m to represent the face of the TBM and a rear plane at –25.0 m.

In the z-direction, the largest gradient of displacement will occur at the face of the TBM, therefore a mesh refinement is applied at the middle plane representing the face of the TBM.
To generate the 3D mesh, follow these steps:

- Click the *Generate 3D mesh* button in the toolbar or select the *Generate 3D mesh* option from the *Mesh* menu.
- Create three z-planes with coordinates 0.0 m, -8.6 m and -25.0 m respectively.
- To refine the mesh in the z-direction at plane A (the front of the TBM), select plane A and click on the corresponding red line in the top view. A window will pop up in which a *Local element size factor* of 0.5 should be entered. Press *OK* to accept this value.
- Click the *Generate* button to start the 3D mesh extension procedure. The 3D mesh is displayed in the Output window. The local refinement is clearly visible.
- Click the *Update* button to return to the geometry input mode.

![3D finite element mesh of the shield tunnel project](image)

**Figure 5.4** 3D finite element mesh of the shield tunnel project

*Initial conditions*

The initial conditions for the project require the generation of water pressures and the generation of initial stresses. The generation of water pressures (i.e. pore pressures and water pressures on external boundaries) can be based on the input of hydrostatic heads or the input of phreatic levels. The input of a phreatic level is the simplest way to define the pore pressures, and in this exercise this method will be used.
A general phreatic level can be defined in the front plane of the model, which is valid for all slices in the model. Under this phreatic level the water pressure distribution is hydrostatic, based on the input of a unit weight of water. The general phreatic level is used for the generation of external water pressures and this line is automatically assigned to all clusters for the generation of pore pressures. As an alternative to this procedure, the individual clusters of the front plane may have a separate phreatic level or an interpolated pore pressure distribution. Once again, these input values are valid for all slices in the model.

In this example only a general phreatic level is defined at mean sea level (MSL). To generate the appropriate initial conditions, follow these steps:

Click the *Initial conditions* button on the toolbar and click *OK* to accept the default value of the unit weight of water, which is 10 kN/m$^3$. The *Water conditions* mode then becomes active.

**Hint:** When a project is input for the first time, the water weight is presented directly on entering the *Water conditions mode*. On re-entering an existing project the input of the water weight can be accessed by selecting the *Water weight* option from the *Geometry menu in the Water conditions mode*.

By default, a *General phreatic level* is generated at the bottom of the geometry and the *pore pressure generation method* is set to *by phreatic level*.

Select *phreatic level* from the toolbar and move the cursor to position (0.0; 0.0) and click the left mouse button. Move 20 m to the right (20.0; 0.0) and click again. Click the right mouse button to finish drawing. The plot now indicates a new *General phreatic level* at MSL, i.e. 2.0 m below the ground surface.

**Hint:** An existing phreatic level may be modified by using the *Selection* button from the toolbar and moving the existing points, or by just drawing a new phreatic level at a new position. On deleting the general phreatic level (by selecting it and pressing the *<Del>* key on the keyboard), the default general phreatic level will be created again at the bottom of the geometry. The graphical input or modification of phreatic levels does not affect the existing geometry.

Click the *Generate water pressures* button (shown by the blue crosses) on the toolbar. The water pressures will then be generated and displayed in the Output window. Click the *Update* button to return to the *Water conditions mode*.

Proceed to the *Geometry configuration* mode by clicking on the 'switch' in the toolbar.

- Generate the initial stresses by means of the $K_0$-procedure using 0.5 as the value of $K_0$. After the generation of initial stresses, click the *Calculate* button and make sure that the project is saved under an appropriate name.
5.2 CALCULATIONS

In practice, the construction of a tunnel is a process that consists of several phases. In this case, we concentrate on the tunnel heading stability and consider that the TBM has already advanced its own length (8.6 m) into the block of soil being modelled. Therefore, the first phase will consist of the excavation of the soil to allow the installation of the TBM, the application of the TBM itself, the lowering of the water level in the TBM, the application of the tunnel face pressure and the application of contraction to simulate the fact that the TBM is conical towards its tail. Also, the adapted material sets (with reduced interface friction and adhesion) are assigned to the first slice in which the tunnel is excavated. To define this first calculation phase, follow these steps:

- Select the first calculation phase (Phase 1).
- Accept all defaults in the General and Parameters tab sheet and press Define in the Loading input box.
- In the Staged construction window, select Slice 1.
- To excavate the tunnel, click once on the cluster inside the TBM to deactivate it.
- Click on the tunnel shell and a selection window will appear in which the options Plate and Negative interface should be selected. Now, the TBM should be active in Slice 1. Also activate the interfaces at the other two parts of the TBM in a similar way.
- The tunnel face pressure needs to be applied to the face of the TBM, therefore select the Plane A tab and double-click the cluster inside the tunnel. A Z-Load on clusters window will appear (Figure 5.5).
- The tunnel face pressure is maintained by a fluid (bentonite) with a unit weight of 14.0 kN/m$^3$. The tunnel face pressure is 90.0 kN/m$^2$ in the negative z-direction at the top of the tunnel (-4.75 m) and 209.0 kN/m$^2$ at the bottom (-13.25 m). The pressure gradient is 14.0 kN/m$^2$/m.

![Z-Load on clusters window](image)

Figure 5.5 The Z-Load on cluster window to define the face pressure.
- Enter a $y_{ref}$ of -4.75 m (corresponding to the top of the tunnel), a $p_{ref}$ of -90.0 kN/m$^2$ and a $p_{inc}$ of -14.0 kN/m$^2$/m. Make sure that the face pressure belongs to Load System A.

- Click the tab sheet of the Front plane. Double-click the tunnel reference point, i.e. the centre of the tunnel. The Tunnel contraction window pops up.

For each plane, a value may be entered for the Contraction parameter, which involves a shortening of the tunnel shell and thus a reduction of the tunnel radius during the calculation. The option is only available for Bored tunnels with shells and can be used to simulate the soil volume loss around the tunnel due to overcutting, conicity of the TBM, or other causes. The value of contraction defines the cross section area reduction as a percentage of the whole tunnel cross section area. In this case the Front plane (i.e. the tail of the TBM) should be given a contraction of 0.5% to simulate the conicity of the TBM.

- While the Front plane is highlighted, enter a value of 0.5 for the contraction parameter and click the OK button to close the tunnel contraction window.

Proceed to the Water conditions mode by clicking on the 'switch' in the toolbar. In the water pressures mode, a Global pore pressure distribution (which is valid for the whole geometry) or a Local pore pressure distribution (which is valid for one slice only) can be applied.

- To obtain a dry tunnel, select the Slice 1 tab and double click the cluster inside the tunnel. The Cluster pore pressure distribution window then appears (Figure 5.6). Choose Cluster dry. Close the window. Now, only locally in Slice 1 (not in all slices) the tunnel cluster is dry.

![Figure 5.6 The Cluster pore pressure distribution window](image)

Click the Generate water pressures button (shown by the blue crosses) on the toolbar. Water pressures will be generated according to the new setting.

- In the Output window the tunnel cluster is shown to be excavated and dry. Click the Update button to return to the water conditions mode.

- Click the Update button to finish the definition of the construction phase. As a result, the Staged construction window is closed and the Calculations window reappears. The calculation phase has now been defined and saved.
The minimum required tunnel face pressure can be found by reducing the tunnel face pressure until the tunnel heading collapses. This calculation phase is rather simple to define:

- Select the second phase (Phase 2) and accept all defaults (Calculation type = 3D Plastic, Start from phase = 1 - <Phase 1>) in the General tab sheet.
- In the Parameters tab sheet, keep the default value for the Additional steps parameters (250) and select the Reset displacements to zero option. In the Loading input box, select Total multipliers.
- Click the Define button or on the Multipliers tab. In the Multipliers tab sheet enter 0 for $\sum M_{loadA}$. All loads defined as load system A (in this case only the Z-Load representing the tunnel face pressure), will gradually be reduced to 0.

The calculation definition is now complete. Before starting the calculation it is advisable to select nodes or stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this, follow the steps given below.

- Click the Set points for curves button on the toolbar.
- Click Plane A and select the following nodes; the bottom of the tunnel, the centre of the tunnel, the top of the tunnel and the ground surface immediately above the tunnel. Click the Update button.
- In the Calculations window, make sure only phase 1 and phase 2 are selected for calculations (blue arrow) and click the Calculate button. The whole calculation may take some time. The first calculation phase should successfully finish, which is indicated by the green tick mark in the list. The second calculation phase should not successfully finish indicating that soil collapse has occurred. The following Log info can be read in the General tab sheet:
  Prescribed ultimate state not reached!
  Soil body collapses.
  Inspect output and load-displacement curve.
- Make sure the second phase is selected (Phase 2).
- Click the Multipliers tab and select the Reached values radio button. The $\sum M_{loadA}$ parameter in the Total multipliers box has reached a value of 0.64, so the minimum tunnel face pressure required to prevent failure is $0.64 \times 90.0 = 57.6$ kN/m$^2$ at the top and $0.64 \times 209.0 = 133.8$ kN/m$^2$ at the bottom of the tunnel. This indicates the minimum pressures that must be applied to avoid active failure.

### 5.3 SAFETY ANALYSIS

In the design of a tunnel it is important to consider not only the final stability, but also the stability during construction. The stability against failure can be defined by means of a safety factor. In structural engineering, a safety factor is usually defined as the ratio of
the collapse load to the working load. For soil structures, however, this definition is not always useful. An alternative definition, that is used extensively in soil mechanics, is:

\[
Safety\ factor = \frac{S_{\text{available}}}{S_{\text{needed for equilibrium}}}
\]

Where \( S \) represents the shear strength. The ratio of the available strength to the computed minimum strength required for equilibrium is the safety factor. By introducing the standard Coulomb condition, the safety factor is obtained as:

\[
Safety\ factor = \frac{c + \sigma_n \tan \phi}{c_r + \sigma_n \tan \phi_r}
\]

Where \( c \) and \( \phi \) are the input strength parameters for the Mohr-Coulomb model and \( \sigma_n \) is the actual normal stress component. The parameters \( c_r \) and \( \phi_r \) are reduced strength parameters that are just large enough to maintain equilibrium. The principle described above is the basis of the method of Phi-c reduction that can be used in PLAXIS to calculate a global safety factor. In this approach the cohesion and the tangent of the friction angle are reduced in the same proportion:

\[
\frac{c}{c_r} = \frac{\tan \phi}{\tan \phi_r} = \sum M_{sf}
\]

The reduction of strength parameters is controlled by the total multiplier \( \Sigma M_{sf} \). This parameter is increased in a step-by-step procedure (by reducing \( c_r \) and \( \tan \phi_r \)) until failure occurs. The safety factor is then defined as the value of \( \Sigma M_{sf} \) at failure, provided that at failure a more or less constant value of \( \Sigma M_{sf} \) is obtained for a number of successive calculation steps.

The Phi-c-reduction calculation option is available as a Calculation type on the General tab sheet. To calculate the global safety factor for the stability of the tunnel heading with the original face pressure, follow these steps:

- Select the third calculation phase and in the General tab sheet, select 3D Phi/c reduction in the Calculation type box.
- The current calculation phase should start from the results of the first phase, i.e. after the original face pressure has been applied. Therefore, change the Start from phase parameter to the first phase (Phase 1) in the Phase box.
- In the Parameters tab sheet, set the Additional steps to 30 (i.e. lower than the default of 100 for a 3D Phi/c reduction calculation) and select the Reset displacements to zero option. Click the Define button.
- In the Multipliers tab sheet, select Input values in the Show box. The first increment of the multiplier for strength reduction (Msf) is preset to 0.1. Accept this value.
- Double click phase 3 to activate it (blue arrow) and click the Calculate button.
5.4 VIEWING OUTPUT RESULTS

After the calculations, the results can be viewed by selecting the phase of interest and clicking the Output button. Figure 5.7 shows the total displacement at the end of phase 1. From this figure, it can be seen that the original face pressure is sufficiently high to keep the tunnel face stable. The displacements at the tunnel face are small. The largest deformations occur above the tail of the TBM. This is due to the applied contraction.

![Deformed mesh at the end of phase 1](image)

To view the value of contraction that actually occurred during the calculation, follow these steps:

- Select Phase 1 and click the Output button.
- Select the Front plane and double-click the TBM. As a result, a 3D plot appears representing the full tunnel, with an indication of the active and inactive parts. The deformations are shown as a deformations plane. A different presentation may be chosen from the presentation combo box.
- Select again the Front plane. The plot title shows the total and incremental values of the realised contraction. The Total realised contraction corresponds to the input value of 0.5%.

In addition to the results of the first phase, it is also interesting to compare the deformations as obtained for the second and the third phase. Both the second and the third phases represent a collapse situation. The second phase (face pressure reduction) shows the soil locally moving inwards (Figure 5.8). The third phase (phi-c reduction) shows a chimney-like failure mechanism reaching to the ground level (Figure 5.9).
The Curves program enables the generation of curves in which the development of multipliers is plotted against the calculation step number or the deformation of a certain point. It is interesting to view the development of the $\Sigma M_{loadA}$ multiplier (Figure 5.10) and the development of the $\Sigma M_{sf}$ multiplier (Figure 5.11).
Figure 5.10 Development of $\Sigma M_{\text{loadA}}$ as a function of the tunnel face displacement

To generate these curves, the following steps need to be taken:

- Start the Curves program, create a new chart and select Lesson 3 from the file requester.

- For the x-axis, select the total displacements of the point corresponding to the centre of the tunnel. For the y-axis, select the multiplier $Sum-M_{\text{loadA}}$. In the Curve settings set only phase 2 to be shown. To do so, select the Curve item from the Format menu. Now click the Phases button. In the Select phases window, make sure only Phase 2 is selected. Click OK to close the Select phases window and click OK to change the curve settings.

- Create a new chart. For the x-axis, select the total displacements of the point corresponding to the centre of the tunnel. For the y-axis, select the multiplier $Sum-M_{\text{sf}}$.

Figure 5.10 shows that, in the second phase, $\Sigma M_{\text{loadA}}$ reaches a value of 0.64, when large inward movements of the tunnel face occur. Figure 5.11 shows that, in the third phase, $\Sigma M_{\text{sf}}$ reaches a value of 4.8 when large inward movements of the tunnel face occur.

Note that the value of $\Sigma M_{\text{sf}}$ may only be regarded as a global safety factor if an approximately constant value (i.e. a horizontal line) is obtained when collapse occurs. This is indeed the case in the third calculation phase (Figure 5.11). However, in this type of application the procedure of phi-c reduction does not give a realistic safety factor. This is because the problem is dominated by the tunnel face pressure, which is not reduced in the phi-c reduction procedure. The method of phi-c reduction is much more...
applicable for embankment or slope stability problems; in these cases it does provide a realistic safety factor.

Figure 5.11 Development of $\Sigma Msf$ as a function of the tunnel face displacement
6  STABILITY OF A DIAPHRAGM WALL EXCAVATION (LESSON 4)

This lesson is concerned with a diaphragm wall that is constructed in a stiff sandy clay layer with a groundwater level at 1.0 m below the surface. The excavation process of a diaphragm wall is executed in a specific sequence to obtain the maximum support from the surrounding soil and to prevent soil collapse. A diaphragm wall consists of a number of individually constructed sections. The construction of one such section is modelled in this exercise.

A single diaphragm section is excavated in three parts and the construction can be modelled in four phases. In the first three phases, the wall is excavated part by part in the sequence as shown in Figure 6.1. During the excavation, fluid bentonite with a unit weight of 11 kN/m$^3$ is simultaneously pumped in the trench so that the bentonite pressure and the arching in the soil prevents the surrounding soil from collapse. After digging of the trench has been completed, in the fourth phase, fluid concrete is poured in the trench and this replaces the bentonite. The hardening of the concrete is not simulated due to limitations in the Introductory version. To observe the stability of the excavation, a safety factor is calculated by means of a phi-c reduction procedure.

![Figure 6.1 Front (left) and plan (right) view of the diaphragm wall section](image)

6.1  INPUT

The diaphragm wall considered in this exercise is 30 m deep and 1.2 m thick. One section is 7.0 m wide and consists of three excavation parts; part I and II are 2.5 m wide...
and part III is 2.0 m wide. The wall is symmetric about its central plane, so only one half of the thickness needs to be modelled.

**Geometry model**
The proposed geometry model is 20.0 m wide and 40 m high as shown in Figure 6.2. The separation between the three parts of the diaphragm wall is modelled by geometry lines. The interaction between the wall and the soil is considered to be fully rough, therefore interfaces are not required.

- Create the basic geometry model as presented in Figure 6.2. The *standard fixities* can be used to generate the boundary conditions.

![Figure 6.2 Geometry model of the diaphragm wall excavation](image)

**Material properties**
The soil is assumed to be homogeneous, and is modelled as a single layer of stiff sandy clay.

- Create a data set for the soil with the parameters given in Table 6.1.
- Assign the stiff sandy clay data set to all clusters.
Table 6.1 Soil and concrete properties

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Stiff sandy clay</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td></td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>drained</td>
<td></td>
</tr>
<tr>
<td>Soil weight above phr. level</td>
<td>$\gamma_{unsat}$</td>
<td>15.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Soil weight below phr. level</td>
<td>$\gamma_{sat}$</td>
<td>18.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young's modulus</td>
<td>$E_{ref}$</td>
<td>5.0 \times 10^4</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>$\nu$</td>
<td>0.30</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion</td>
<td>$c_{ref}$</td>
<td>15.0</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\varphi$</td>
<td>30.0</td>
<td>-</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0.0</td>
<td>-</td>
</tr>
</tbody>
</table>

2D Mesh Generation

A very coarse mesh is considered in this example, with a refinement of the clusters that are to be excavated. To generate this mesh, follow these steps:

- Select all excavation sections together by holding the <Shift> key. Choose Refine cluster from the Mesh menu. The Output window shows the refined mesh (Figure 6.3). Click the Update button to return to the geometry input.

Figure 6.3 2D finite element mesh of the diaphragm wall excavation
3D Mesh Generation

The diaphragm wall is 1.2 m thick. Since the problem is symmetrical, only one half (a thickness of 0.6 m) is modelled. The model is extended 10.0 m in the $z$-direction to allow for any possible mechanism to occur in this and to avoid any influence from the boundaries. Three planes are entered, a Front plane at $z = 0.0$ m, Plane A at $z = -0.6$ m and a Rear plane at $z = -10.0$ m. As the largest gradient of displacement in the $z$-direction will occur around Plane A, a local mesh refinement is applied here.

To generate the 3D mesh, follow these steps:

- In the 3D mesh generation window, create $z$-planes at 0.0 m, -0.6 m and -10.0 m.
- To refine the mesh in the $z$-direction at Plane A, select Plane A in the table and click on the corresponding red line in the top view. A window will pop up in which a local mesh refinement of 0.2 should be specified. Press OK.
- After clicking the Generate button, the 3D mesh extension procedure is started and the 3D mesh is displayed in the Output window.
- Inspect the mesh and click Update to return to the geometry input mode.

![Figure 6.4 3D finite element mesh](image)

Initial conditions

In the initial conditions, a unit water weight of 10.0 kN/m$^3$ is entered. The initial water pressures are generated on the basis of a horizontal general phreatic line at a level of $y = 39.0$ m (through points $(0; 39.0)$ and $(20.0; 39.0)$). The initial stress field is generated by
means of the $K_0$-procedure using a $K_0$-value of 0.5 in all clusters. After this, proceed to Calculations.

### 6.2 CALCULATIONS

The calculation consists of four phases. In the first phase, part I of the excavation is removed and simultaneously filled with bentonite. The bentonite, with a unit weight of 11 kN/m$^3$, is simulated by means of an artificial 'water' pressure that increases linearly with depth. This pressure replaces the original water pressure inside the excavation. In the second and third phases of the excavation parts II and III are removed and filled with bentonite. In the fourth phase, the entire excavated trench is filled with fluid concrete. The fluid concrete with a unit weight of 24 kN/m$^3$ is simulated by change in the artificial water pressure. The hardening of the concrete is not simulated due to limitations in the Introductory Version.

All calculation phases are defined as 3D Plastic calculations of the Staged construction type and standard settings for all other parameters. The instructions given below are limited to a description of how the phases are defined within the Staged construction mode.

**Phase 1**

- In Slice 1, deactivate the two clusters of part I (i.e. the left section) of the diaphragm wall.

![Figure 6.5 Excavation of part I](image)
Switch to the water conditions mode.

- In Slice 1, double-click one of the two clusters of part I of the excavation to specify the local pore pressure distribution. Select *User defined pore pressure distribution* and enter $y_{\text{ref}} = 40.0$ m, $p_{\text{ref}} = 0.0$ kN/m$^2$ and $p_{\text{inc}} = -11.0$ kN/m$^2$/m.
- Do the same for the other cluster of part I in Slice 1.
- Click the *Generate water pressures* button. A bentonite pressure is now defined in part I of the excavation, starting at 0 kN/m$^2$ at the reference level of 40.0 m and increasing at 11.0 kN/m$^2$ per m depth, resulting in 330 kN/m$^2$ at the bottom of the excavation.

**Phase 2**

- In Slice 1, excavate part II (i.e. the right section) of the diaphragm wall.
- Switch to the water conditions mode.
- In Slice 1, double-click one of the two clusters of part II of the excavation to specify the local pore pressure distribution. Select *User defined pore pressure distribution* and enter $y_{\text{ref}} = 40.0$ m, $p_{\text{ref}} = 0.0$ kN/m$^2$ and $p_{\text{inc}} = -11.0$ kN/m$^2$/m.
- Do the same for the other cluster of part II in Slice 1.
- Generate the 'water' pressures. The required bentonite pressure is now present in part I and part II of the diaphragm wall.

![Figure 6.6 Excavation of part II](image-url)
Phase 3

- In Slice 1, excavate part III (i.e. the middle section) of the diaphragm wall.
- Switch to the water conditions mode.
- In Slice 1, double-click one of the clusters of part III in Slice 1 to specify the User defined pore pressure distribution ($y_{ref} = 40.0 \text{ m}, p_{ref} = 0.0 \text{ kN/m}^2$ and $p_{inc} = -11.0 \text{ kN/m}^2$/m).
- Do the same for the other cluster of part III in Slice 1.
- Generate the ‘water’ pressures. The bentonite pressure is now present in all sections of the diaphragm wall.

![Figure 6.7 Excavation of part III](image)

Phase 4

- The bentonite in the excavation is now replaced by fluid concrete with a weight of 24.0 kN/m$^3$. Therefore switch to the water conditions mode.
- In Slice 1, double-click one of the diaphragm wall clusters to modify the User defined pore pressure distribution. Change the value of $p_{inc}$ to $-24.0 \text{ kN/m}^2$/m. The other parameters must be kept at their original values ($y_{ref} = 40.0 \text{ m}, p_{ref} = 0.0 \text{ kN/m}^2$).
Do the same for the other five diaphragm wall clusters and generate the required pressures to model the wet concrete. The pressure at the bottom of the excavation is now 720 kN/m².

![Image of pressure distribution](image)

**Figure 6.8 Replacing bentonite by fluid concrete**

It is expected that Phase 3 is most critical, because the support pressure from the bentonite is low. Also, the excavation is at its full width, which reduces the possibility for lateral arching. The stability after Phase 3 is checked using a phi-c reduction calculation. Therefore the following steps need to be taken:

**Phase 5**

- Select the last phase and choose as Calculation type: 3D Phi/c reduction.
- The safety factor will be calculated for phase 3. Select 3 - <Phase 3> for the Start from phase parameter in the Phase box of the General tab sheet.
- In the Parameters tab sheet, set the number of additional steps to 40, select Reset displacements to zero and press Define.
- In the Multipliers tab sheet, keep the value of Msf at 0.1.

The calculation phases have now been defined. It is now advisable to select some points for load-displacement curves (for example in Plane A point (10.0;12.9;-0.6). Start the calculation by clicking on the Calculate button.
6.3 OUTPUT

The stability of the excavation can be evaluated from the calculated safety factor after each excavation stage. Due to limitations in the Introductory Version, only phase 3 is evaluated here.

Use the Curves program to plot \( \text{Sum-Msf} \) (the safety factor) as a function of the displacements \( |U| \). Figure 6.9 displays the results. The safety factor is almost 2.4.

![Graph showing Sum-Msf as a function of displacement](image)

Figure 6.9 \( \text{Sum-Msf} \) (safety factor) as a function of the total displacement

An important phenomenon that keeps the excavation stable is arching in the soil. This phenomenon is shown in Figure 6.10, Figure 6.11 and Figure 6.12. To create such plots, make a horizontal cross-section at the mid-height of the diaphragm wall and select Principal stresses from the Stresses menu. Rotate the plot such that the model is viewed from the top.

![Diagram showing principal stresses](image)

Figure 6.10 Principal stresses near the surface in Phase 1 showing the arching effect
Figure 6.11 Principal stresses near the surface in Phase 2 showing the arching effect

Figure 6.12 Principal stresses near the surface in Phase 4 showing the arching effect
## APPENDIX A - MENU TREE

### A.1 INPUT MENU

<table>
<thead>
<tr>
<th>INPUT MENU</th>
<th>File</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New</td>
<td>Undo</td>
</tr>
<tr>
<td>View</td>
<td>Open</td>
<td>Copy</td>
</tr>
<tr>
<td>View</td>
<td>Save</td>
<td>As</td>
</tr>
<tr>
<td>View</td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>Work directory</td>
<td>Import</td>
</tr>
<tr>
<td>View</td>
<td>General settings</td>
<td>(recent projects)</td>
</tr>
<tr>
<td>View</td>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Loads</th>
<th>Geometry</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard fixities</td>
<td>Geometry line</td>
<td>Zoom in</td>
</tr>
<tr>
<td>Total fixities</td>
<td>Plate</td>
<td>Zoom out</td>
</tr>
<tr>
<td>Horizontal fixities</td>
<td>Geogrid</td>
<td>Reset view</td>
</tr>
<tr>
<td>Vertical fixities</td>
<td>Node-to-node anchor</td>
<td>Table</td>
</tr>
<tr>
<td>Rotation fixity (plates)</td>
<td>Fixed-end anchor</td>
<td>Rulers</td>
</tr>
<tr>
<td>Distributed load system A</td>
<td>Interface</td>
<td>Cross hair</td>
</tr>
<tr>
<td>Distributed load system B</td>
<td>Grid</td>
<td>Axis</td>
</tr>
<tr>
<td>Distributed load system A</td>
<td>Tunnel</td>
<td>Snap to grid</td>
</tr>
<tr>
<td>Distributed load system B</td>
<td></td>
<td>Point numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chain numbers</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mesh</th>
<th>Materials</th>
<th>Load</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global coarseness</td>
<td>Soil &amp; interfaces</td>
<td>Standard fixities</td>
</tr>
<tr>
<td>Refine global</td>
<td>Plates</td>
<td>Total fixities</td>
</tr>
<tr>
<td>Refine cluster</td>
<td>Geogrids</td>
<td>Horizontal fixities</td>
</tr>
<tr>
<td>Refine line</td>
<td>Anchors</td>
<td>Vertical fixities</td>
</tr>
<tr>
<td>Refine around point</td>
<td></td>
<td>Rotation fixity (plates)</td>
</tr>
<tr>
<td>Reset all</td>
<td></td>
<td>Distributed load system A</td>
</tr>
<tr>
<td>Generate</td>
<td></td>
<td>Distributed load system B</td>
</tr>
<tr>
<td>Generate 3D</td>
<td></td>
<td>Point load system A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Point load system B</td>
</tr>
</tbody>
</table>

---

A-1
### INITIAL CONDITIONS MENU

<table>
<thead>
<tr>
<th>File</th>
<th>View</th>
<th>Geometry</th>
<th>Generate</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Zoom in</td>
<td>Water weight</td>
<td>Water pressures</td>
<td>Manuals</td>
</tr>
<tr>
<td>Save as</td>
<td>Zoom out</td>
<td>Phreatic level</td>
<td>Initial stresses</td>
<td>Check memory &amp; speed</td>
</tr>
<tr>
<td>Print</td>
<td>Reset view</td>
<td></td>
<td></td>
<td><a href="http://www.plaxis.com">http://www.plaxis.com</a></td>
</tr>
<tr>
<td>General settings</td>
<td>Rulers</td>
<td></td>
<td></td>
<td>About</td>
</tr>
<tr>
<td>Exit</td>
<td>Cross hair</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Grid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Snap to grid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Point numbers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chain numbers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top View</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A.2 CALCULATIONS MENU

File
  Open
  Save
  Print

Edit
  Next phase
  Insert phase
  Delete phase(s)

View
  Calculation manager
  Select points for curves

Calculate
  Current project

Help
  Manuals
  Check memory & speed
  http://www.plaxis.com
  Disclaimer
  About

Exit
  Work directory
  Recent projects
  Select all
  Copy to clipboard
<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Geometry</th>
<th>Deformations</th>
<th>Stresses</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Copy</td>
<td>Zoom in</td>
<td>Structures</td>
<td>Deformed mesh</td>
<td>Effective stresses</td>
<td>Cascade</td>
<td>Manuals</td>
</tr>
<tr>
<td>Close</td>
<td>Scale</td>
<td>Zoom out</td>
<td>Materials</td>
<td>Total displacements</td>
<td>Total stresses</td>
<td>Tile horiz.</td>
<td>Plaxis website</td>
</tr>
<tr>
<td>Close all</td>
<td>Interval</td>
<td>Reset view</td>
<td>Phreatic line</td>
<td>Horizontal displ. (x)</td>
<td>Cartesian eff. stresses</td>
<td>Tile vert.</td>
<td>Disclaimer</td>
</tr>
<tr>
<td>Print</td>
<td>Scan line</td>
<td>Cross section</td>
<td>Loads</td>
<td>Horizontal displ. (z)</td>
<td>Cartesian total. stresses (active)</td>
<td></td>
<td>About</td>
</tr>
<tr>
<td>Work dir.</td>
<td>Table</td>
<td>Fixities</td>
<td>Vertical displacements</td>
<td>Overconsolidation ratio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Rulers</td>
<td>Presc.displacements</td>
<td>Phase displacements</td>
<td>Plastic points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Title</td>
<td>Connectivity plot</td>
<td>Total increments</td>
<td>Active pore pressure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Legend</td>
<td>Elements</td>
<td>Hor. increments (x)</td>
<td>Excess pore pressure</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid</td>
<td>Nodes</td>
<td>Hor. Increments (z)</td>
<td>Groundwater head</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Axis</td>
<td>Stress points</td>
<td>Vertical increments</td>
<td>Flow Field</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td>Element numbers</td>
<td>Total strains</td>
<td>Degree of saturation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partial geometry</td>
<td>Node numbers</td>
<td>Cartesian strains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General info</td>
<td>Stress point numb.</td>
<td>Incremental strains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load info</td>
<td>Material set numb.</td>
<td>Incrm. cartesian strains</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material info</td>
<td>Cluster numbers</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculation info</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### APPENDIX A - MENU TREE

**OUTPU MENU (2)**

**Cross section:**

<table>
<thead>
<tr>
<th>Deformations</th>
<th>Stresses</th>
<th>Plates:</th>
<th>Deformations</th>
<th>Forces</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total displacements</td>
<td>Principal stresses</td>
<td></td>
<td>Total displacements</td>
<td>Axial N1, N22</td>
</tr>
<tr>
<td>Horizontal displacem. (x)</td>
<td>Effective normal stresses</td>
<td></td>
<td>Horizontal displ. (x)</td>
<td>Shear Q12, Q23, Q13</td>
</tr>
<tr>
<td>Horizontal displacem. (z)</td>
<td>Total normal stresses</td>
<td></td>
<td>Horizontal displ. (z)</td>
<td>Bending moments M11</td>
</tr>
<tr>
<td>Vertical displacements</td>
<td>Shear stresses</td>
<td></td>
<td>Vertical displ.</td>
<td>Bending moments M22</td>
</tr>
<tr>
<td>Phase displacements</td>
<td>Shear stresses (z)</td>
<td></td>
<td>Total increments</td>
<td>Torsion moments M12</td>
</tr>
<tr>
<td>Total increments</td>
<td>Cartesian effective stresses</td>
<td></td>
<td>Horizontal incr. (x)</td>
<td></td>
</tr>
<tr>
<td>Horizontal increments (x)</td>
<td>Cartesian total stresses</td>
<td></td>
<td>Horizontal incr. (z)</td>
<td></td>
</tr>
<tr>
<td>Horizontal increments (z)</td>
<td>Overconsolidation ratio</td>
<td></td>
<td>Vertical increments</td>
<td></td>
</tr>
<tr>
<td>Vertical increments</td>
<td>Effective mean stresses (p')</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Principal strains</td>
<td>Total mean stresses (p)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal strain</td>
<td>Deviatoric stress (q)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shear strain</td>
<td>Active pore pressure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shear strain (z)</td>
<td>Excess pore pressure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cartesian strains</td>
<td>Groundwater flow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Normal strain increments</td>
<td>Groundwater head</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shear strain increments</td>
<td>Degree of saturation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shear strain (z) increments</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cartesian strain increments</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Interfaces:**

<table>
<thead>
<tr>
<th>Deformations</th>
<th>Stresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total displacements</td>
<td>Effective normal stresses</td>
</tr>
<tr>
<td>Horiz. displ. (x), (z)</td>
<td>Shear stresses</td>
</tr>
<tr>
<td>Vertical displ.</td>
<td>Shear stresses (z)</td>
</tr>
<tr>
<td>Total increments</td>
<td>Relative shear stresses</td>
</tr>
<tr>
<td>Horiz. incr. (x), (z)</td>
<td>Active pore pressures</td>
</tr>
<tr>
<td>Relative displ.</td>
<td>Excess pore pressures</td>
</tr>
<tr>
<td>Relative incr.</td>
<td></td>
</tr>
</tbody>
</table>
A.4 CURVES MENU

Curves Menu:

- File
  - New
  - Open
  - Save
  - Add curve
  - Delete chart
  - Close
  - Close all
- Edit
  - Copy
- View
  - Zoom in
  - Reset view
  - Table
  - Legend
  - Value indication
- Format
  - Curves
  - Chart
- Window
  - Cascade
  - Tile vertically
  - Tile horizontally (active windows)
- Help
  - Manuals
  - http://www.plaxis.com
  - Disclaimer
  - About

CURVES MENU

[Diagram of menu options]

Exit
Print
Work directory
(recent projects)
APPENDIX B - CALCULATION SCHEME FOR INITIAL STRESSES

DUE TO SOIL WEIGHT

Start

Yes

Horizontal surface

No

K₀-procedure
initial stresses
Σ-Mweight = 1

Gravity loading
plastic calculation
load advancement
ultimate-level
Σ-Mweight = 1

Ready

Examples of non-horizontal surfaces, and non-horizontal weight stratifications are: